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INTRODUCTION
This manual describes the features, functions, configuration, and general usage of Eric’s Robot
Backer Upper (ERBU). This manual is written for ERBU version 3.0. Use the HelpAbout
menu to determine which version of ERBU you are running. Even if you are running an earlier
version, this manual may still have some relevance. The screen captures in this manual are
taken from machines running Win7 and Win10.

1 APPLICATION OVERVIEW
1.1 END USER LICENSE AGREEMENT
Eric’s Robot Backer Upper(hereinafter referred to as ERBU) and the ERBU logo are
trademarks of Eric Labs LLC. © 2014-2022 Eric Labs LLC. All rights reserved. ERBU is
furnished under license and may be used or copied only in accordance with the terms of such
license.
Section 1
Eric Labs LLC grants to you a nonexclusive, nontransferable license to use ERBU
(“Software”) only upon the condition that you accept all of the terms contained in this Software
License Agreement.
End User License
ERBU may only be installed and used on a single physical PC or CPU for which you have
obtained a registration file from Eric Labs LLC or an authorized reseller. You may neither
install it nor otherwise use it on more than one computer system (real or virtual) at the same
time. The software registration process locks ERBU to a specific computer system and the
registration is not transferable. You may make copies of the ERBU installation CD or
download for backup or archival purposes in support of your permitted use of the software.
Data and configuration files are excluded from the single computer limit, are not locked by the
registration process, and can be shared freely between other authorized ERBU users.
Section 2
In the event you would like to transfer your registration to a different computer, you must
obtain written permission and a new registration from Eric Labs LLC. Eric Labs LLC reserves
the right to deny a transfer request for any reason. Upon a registration transfer, ERBU must
be uninstalled from the original computer, and under no circumstances be used on more than
one computer at a time.
Section 3
The registration process locks ERBU to a specific PC based on attributes of the PC. If at any
point your registration becomes invalid due to changes in the attributes or you lose your
registration file, you may petition Eric Labs LLC for a new registration. Eric Labs LLC
reserves the right to deny a petition for any reason.
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Section 4
This license is not a sale. Title, ownership right, and intellectual property rights in and to the
Software and Documentation shall remain wholly vested in Eric Labs LLC. You agree to
abide by the copyright laws and all other applicable laws of the United States. You
acknowledge that the Software in source code remains a confidential trade secret of Eric Labs
LLC. Failure to comply with the above restrictions will result in automatic termination of this
license and will make available to Eric Labs LLC other legal remedies. You may not disclose
any of Eric Labs LLC’s proprietary or trade secret information relating to the Software to any
third party. You agree to secure and protect the Software, Documentation and copies thereof
in a manner consistent with the maintenance of Eric Labs LLC’s right therein and to take
appropriate action by instruction or agreement with anyone who is permitted by you to have
access to the Software, to satisfy your obligation hereunder.
Section 6
Eric Labs LLC makes no warranties, expressed or implied, with respect to the Software,
and/or Documentation, and specifically disclaims the implied warranties of merchantability and
fitness for particular purposes. Eric Labs LLC does not warrant that the operation of the
Software will be uninterrupted or error free.
To the maximum extent permitted by law, in no event shall Eric Labs LLC be liable for any
special, incidental, consequential or punitive damages whatsoever, including claims of lost
profits, business interruptions, lost information, or other damages arising out of the use or
inability to use the Software. In all events, Eric Labs LLC’s sole obligation or liability under
this license is the replacement or repair of the Software or, at our option a refund of the
purchase price.
Section 7
The Software and Documentation are “commercial computer software” and “commercial
computer software documentation,” respectively, and are provided with the Restricted Rights
under Federal Acquisition Regulations (FAR) and agency supplements to them. Use,
duplication or disclosure by the U.S. Government is subject to restrictions as set forth in
subparagraph (c)(1)(ii) if the Rights in Technical Data and Computer Software clause at DFAR
252.227-7013 et seq. and DFAR 252.227-7015, and subparagraphs (a) though (d) of the
Commercial Computer Software Restricted Rights at FAR 52:227-19, as applicable, or similar
clauses in the NASA FAR Supplement. Manufacturer is Eric Labs LLC, Rochester Hills MI
48306.
Section 8
Eric Labs LLC may terminate this agreement immediately and without notice if you fail to
comply with any term or condition of the Agreement. In event of the termination of this
Agreement, all the sections of this agreement will survive except Section 1.
Section 9
The laws of the State of Michigan, U.S.A., shall govern the interpretation of this Agreement,
irrespective of the fact that one of the parties now is or may become a resident of a different
state or country. The parties shall submit all disputes, which arise under this Agreement to
state or federal courts located in the county of Oakland, State of Michigan, for resolution. In
such event, the parties to this Agreement each consent to the in personam jurisdiction and
venue of such courts. The parties agree that service of process upon them in any such action
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may be made if delivered in person, by courier service, by telegram, by fax, or by first class
mail, and shall be deemed effectively given upon receipt.
Section 10
This agreement sets forth the entire agreement between you and Eric Labs LLC pertaining to
the licensing of the Software, and supersedes in its entirety any and all written or oral
agreements previously existing between the parties with respect to such subject matter. If any
provision of this Agreement is held invalid or unenforceable, such provision shall be revised to
the extent necessary to cure the invalidity or unenforceability, and the remainder of this
Agreement shall continue in full force and effect. In the event of any conflict between any
provision of this Agreement and any applicable law, the provision or provisions of the
Agreement affected shall be modified to remove such conflict and permit compliance with
such law and so modified this Agreement shall continue in full force and effect. This
Agreement may not be assigned without the written consent of Eric Labs LLC.

1.2 COMPATIBILITY AND SYSTEM REQUIREMENTS
ERBU has been tested to be compatible with and is intended to run on 64bit PC’s running
Microsoft Windows 7, 8, or 10. ERBU has been structured to work with multiple robot brands,
but only FANUC is currently supported. If you need ERBU to run on 32bit versions of
Windows including Windows XP, you must use ERBU 2.0.
The PC hardware requirements for ERBU are minimal. 1GB of RAM and 20MB of drive
storage are sufficient for ERBU. The storage requirements are also based on the number
of backups you want to make. The size of backups can vary greatly based on the file
types being backed up. Image backups of modern robots can reach 128MB.
See Section 1.3 (the next section) for additional requirements.

1.3 SOFTWARE DEPENDANCIES
OPERATING SYSTEM DEPENDANCIES
ERBU is written using Microsoft Visual Basic .NET. Your computer will need the latest .NET
framework installed. If you find that you need an updated framework, you can find them at
http://msdn.microsoft.com/en-US/vstudio/gg189183.
ERBU does have some interoperability requirement that might require the Visual Basic 6.0
run-time files to be installed on your computer. If your system does not have the run-times
installed, you can download the installation program at http://www.microsoft.com/enus/download/details.aspx?id=24417. The filename is vbrun60sp6.exe if the file is no longer
available from this site. Microsoft has an updated package available at
https://www.microsoft.com/en-us/download/details.aspx?id=7030.
The PC running ERBU must have the ability to read and write to Microsoft Access databases.
This ability comes when Microsoft Office is installed. You can download the Access runtimes
for free from Microsoft if you need them.
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Some other functionality depends on Windows API's. These are normally installed with
Windows and should not cause problems.
FANUC PC FILE DEPENDANCIES
ERBU 3.0 has eliminated all FANUC dependencies that were required to run ERBU 2.0. Of
course if you’re working with virtual robots, you will need the Robot Neighborhood which is
installed by Roboguide(RTL-ROBGUIDExxx) or Robot Server(RTL-RSR).
FANUC ROBOT DEPENDANCIES
On the FANUC robot side of things, you will need to have PC Interface installed to access
some features of ERBU. The basic backup ability of ERBU does not require PC Interface but
the advanced features do. The features that require PC Interface are:
“Launch RobotDemo”
“Cycle Power”
“Synchronize Clock”
“Run CF file locally”
“Suppress TP comments”
“Authenticate robot by identifier”
“Overwrite protected files”
ERBU has been tested on North American robots running Handling Tool version 7 and later.
It may run on earlier versions, but has not been tested.
THIRD PARTY APPLICATIONS
ERBU has the ability to launch some 3rd party applications. To use these applications, you will
need to have them installed on your computer. These applications are:
Internet Explorer – This application is used for browsing robot web pages and comes
with Windows. It has been tested to be compatible. Other browsers
may work but have not been tested. IE11 is the only browser
supported by FANUC’s vision tools. With iB Plus controllers, other
browsers work well, however ERBU will launch IE when robot when
pages are displayed.
Telnet –

This application is a telnet client that is used to start a KCL/SMON
session to the robot. The demo version of PowerTerm 5.2.2 has
been tested to be compatible. Later versions lost support for
command line arguments, so they are less useful than older
versions. If you don’t have a Telnet program and just need to send
KCL commands to the robot, you can configure ERBU to point to
itself and it will use the ERBU built-in KCL emulator called KCL
Commander.
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RobotDemo –

This application is included with FANUC’s PC Developers Kit as an
example program. It is very useful for accessing many functions of
the robot through a network connection. This application is capable
of a lot of things that most people will never use. There is a
simplified version that is sometimes distributed with ERBU. If this
application is not present, you will not be able to launch RobotDemo.

Text Editor –

When ERBU is required to display a text file, it will use the text editor
that has been associated with the file extension. ERBU will launch
whatever editor is associated with the file being opened. MultiEdit
v9.1 and v2008, UltraEdit v25 and NotePad++ v7.6 have been tested
to be compatible for such a purpose.

Compression –

This is the compression program that will be used to archive
backups. WinRAR v5.4 has been tested to be compatible with
ERBU. You can specify another compression program, or choose to
use the built in Windows compression.

Compare –

This is used to compare text files such as LS files. WinMerge 2.12.4
has been tested to be compatible with ERBU. ExamDiff is a similar
program and v1.9 has been tested to be compatible. Beyond
Compare 3 has also been tested.

Adobe Reader–

This is required to view the ERBU User’s Manual.

ERBU SUPPORT FILES
ERBU requires a couple of files to run and these files should come with ERBU.
The main support file is the robot database file. It is named ROBOTBACKUPCONFIG.MDB
and is located in the ERBU application directory. This file can be viewed and modified by
Microsoft Access, however this is not recommended and should only be done if the file
becomes damaged and must be repaired. This file must be present for ERBU to run. You
can specify a different database name or location if you choose.
Another file used by ERBU is ERBI.INI. This contains a lot of the configuration information
required by the ERBU interface. The INI file does not contain project or robot specific
information; it is an XML file that can be edited, but this is not recommended.

1.4 DEMO VERSION VERSUS REGISTERED VERSION
There are two versions of ERBU, a demo version and a registered version.
The demo version is meant to demonstrate the functionality of ERBU, but is limited to a single
project containing a single robot.
The registered version has all the functionality of the demo version but it has no limit on the
number of projects or robots.
When you download and install ERBU, the software will be in the demo mode by default. To
upgrade to the full version, you must register your product and purchase a license thru the
product website.
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1.5 INSTALLING ERBU
This section will guide you through a typical installation procedure for ERBU.
You can download the ERBU installer from www.robotbackerupper.com/downloads.aspx.
The installer will have a name like 3.0.xx.exe and will be digitally signed by Eric Labs LLC.
Once downloaded follow the steps below to install ERBU.
1) Run the 3.0.xx.exe executable.
2) Read, understand and agree to the End User License Agreement.
3) Choose the location to install ERBU.
The default location is <Program Files>\ERBU.
The approximate size of the install will be noted in the installation wizard.
4) Optionally add a folder to the Start Menu.
5) Optionally add a desktop icon.
6) Confirm your installation options.
7) Click the “Install” button once your options are confirmed.
8) Click the “Finish” button to close the installer.
9) If this is a first-time installation and you chose to Launch ERBU, then you will be presented
with a registration window.

1.6 REGISTERING ERBU
If you get a message stating that you are not authorized to use the application, it’s because
you’re not. You are required to purchase a license to use the full functionality of ERBU.
However, starting with v3.0.51, ERBU has a limited demo version that can be used if you want
to try it before you buy it. If you are not using a full licensed version, you will see the message
box below when starting ERBU (assuming you have an internet connection).
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www.robotbackerupper.com

When you get this message, you can choose to register or continue with a limited demo
version. There are two methods for registering. Method 1 is the easiest, but requires the PC
running ERBU to have an internet connection. Method 2 is for registering software on a PC
that has no internet connection.
Method 1: Using the registration message box
1) Using the registration message box, copy your registration key to the clipboard
by highlighting the key and pressing CTRL+C.
2) Navigate to http://www.robotbackerupper.com/register.aspx.
3) Paste your registration key into the text box on the webpage by pressing
CTRL+V. See example text box from webpage below:

4) Click the Submit button.
5) If the key is valid, your browser will navigate to a page showing the key you
submitted. Click the Pay with Card button.
6) Your browser will overlay a credit card prompt.
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7) Complete the payment process through the credit card prompt.
8) If you complete the transaction, your bowser will navigate to a page showing
your authorization key.
9) Copy the authorization key from the webpage by highlighting it and pressing
CTRL+C.
10) Paste your authorization key into the ERBU registration message box by
pressing CTRL+V.
11) Once the authorization key is pasted, the “Register Now” button will become
enabled.
12) Click the “Register Now” button.
13) You now have a licensed copy of ERBU subject to the terms of the End User
License Agreement in Section 1.1.
Notes on Method 1:
1) If you complete the payment process through Stripe, but you are navigated to a
page that says that Stripe did not complete there are several reasons this could
happen. If you paid with a currency other than US dollars, there could be a delay
in the processing. The payment method failed for some reason (insufficient
funds, card expired, etc.)
2) In addition to the authorization key presented on the webpage, you will receive
an email with the key for your permanent records. If your payment completes, but
you do not receive your authorization key within 24 hours, use the contact page
on the ERBU website to ask for a resolution.
Method 2: Using files
1) If the PC you are licensing the software on does not have an internet
connection, the registration message box shown above will be missing the
registration key text box.
2) ERBU will create a file called “register.rf” in its executable folder.
3) Using Windows Explorer, find the “register.rf” file and copy it to a removable
media source.
4) Take the media disk with the “register.rf” file to a computer that has internet
access.
5) Navigate to http://www.robotbackerupper.com/register.aspx.
6) On the webpage, click the Browse button and select the “register.rf” file from
the removable media source.
7) Click the Submit button.
8) If the key is valid, your browser will navigate to a page showing the key you
submitted. Click the Pay with Card button.
9) Your browser will overlay a credit card prompt.
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10) Complete the payment process through the credit card prompt.
11) If you complete the transaction, your bowser will navigate to a page showing
your authorization key and supply a link where you can download the
“authorize.rf” file.
12) Download the “authorize.rf” file to the removable media source.
13) Take the removable media back to the PC that will be running ERBU.
14) Using Windows Explorer, copy the “authorize.rf” to the ERBU executable
folder.
15) Restart ERBU.
16) You now have a licensed copy of ERBU subject to the terms of the End User
License Agreement in Section 1.1.
Notes on Method 2:
1) If you complete the payment process through Stripe, but you are navigated to a
page that says that Stripe did not complete there are several reasons this could
happen. If you paid with a currency other than US dollars, there could be a delay
in the processing. The payment method failed for some reason (insufficient
funds, card expired, etc.)
2) In addition to the download link presented on the webpage, you will receive an
email with a link to the same file. The link is permanent so you can re-download
the authorization file anytime. If your payment completes, but you do not receive
your authorization key within 24 hours, use the contact page on the ERBU
website to ask for a resolution.
Free copies of ERBU are available for beta testers.
Testers are encouraged to submit bug reports.
All other users are encouraged to submit ideas.

1.7 GETTING UPDATES
This section will guide you through how to update your installation of ERBU.
The updates are a replacement executable file that will update the features, fix bugs or
enhance performance of ERBU. If support files (configuration database, INI file, etc.) need
to be updated, then the executable will update these too.
Updates are free for both the demo and registered versions.
If you have the option "Check for updates on startup" selected in the ERBU setup preferences
and you have an internet connection, then ERBU will check the website for updates when
ERBU starts. If updates are available, you will be notified on startup.
You can download ERBU updates from www.robotbackerupper.com/downloads.aspx.
The updater is downloaded by clicking the "Executable Only" button on the webpage.
The updater will be named erbu.exe and will be digitally signed by Eric Labs LLC.
Once downloaded, follow the steps below to update ERBU.
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1) Close any running copies of ERBU and be sure that the database and INI files are not
open for edit.
2) If you might want to revert to your previous version of ERBU, then you will need to make
backup copies of the ERBU executable, the configuration database and the INI file.
3) Copy the new downloaded executable into your ERBU directory. Overwrite your old
copy.
4) Run the erbu.exe executable.
5) There may be message windows presented as ERBU updates various files.
6) You now have an updated copy of ERBU.

1.8 GETTING STARTED
This section will guide you through the steps to start your first backup.
CONFIGURATION OF THE ERBU INTERFACE
To get the most out of ERBU, it’s important to understand what features are available
and the best way to configure them to meet your needs.
Most of the ERBU user preferences are configured through the Setup menu item on the
Main Screen.
Backup Settings
Choosing the Backup sub menu will open the Backup Settings window. See section
1.16 for information on the Backup Settings window.
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A typical configuration for this window is:

The purpose of each of these settings is hinted at by hovering your mouse over the text
of the setting.
General Preferences
Choosing the Preferences sub menu will open the General Preferences window. See
section 1.17 for information on the Preferences window.

Page 13

ERBU User’s Manual
A typical configuration for this window is:

The purpose of each of these settings is hinted at by hovering your mouse over the test
of the setting. The list of settings is scrollable.
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ADDING A PROJECT
The robots in ERBU are organized into Projects. This section will guide you through the
steps to add a project.
 On the main window click the Add button above the Projects list.

 On the Add Project window, enter a unique project name.

 You can optionally setup the other project properties now.
ADDING A ROBOT
If you’ve added a Project to ERBU, the next step is to start adding robots. This section
will guide you through the steps to add a robot.


On the main window click the Add button above the Robots list.



On the Add Project window choose the Robot Brand.
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If "FANUC" is chosen for the robot brand, then a button will appear in the lower
left corner of the window. This button will open a dialog which will auto-detect
FANUC robots on the network, and allow you to choose from a list of robots to
add to your project.


Enter a unique robot name. Spaces are not allowed in the name.



Enter the IP address for the robot.



You can optionally setup the other robot properties now.
As you enter data into the window, the data will be validated. If invalid data is
entered, the text field background will turn light red.

MAKING A BACKUP
If you’ve added a robot, the next step is to check the robot configuration and
make a backup.
Your added robot should appear in the robot list.
To determine if the network connection between the robot and the local PC is
working, you can check the indicator in the rightmost column for that robot. If a
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red “x” is shown, then that robot is not responding to a ping. If the robot is
responding to a ping a green “●” will be shown.
If the robot is available on the network, then you can click the checkbox beside
the robot name to designate it for backup.
To begin a backup, click the Backup button. The Transfer window will open and
show the backup progress. Once the backup completes, you can explore the
backup location by right clicking the robot on the Main window and selecting
“Explore Latest…”.

1.9 ERBU APPLICATION DIRECTORY
This is the directory where ERBU and its support files are installed. This can be anywhere
you would like it to be. The tested configuration is to have it on the same drive as your
backups. The recommended default location is "C:\Program Files (x86)\ERBU\".

1.10

ROBOT BACKUP DIRECTORIES

ERBU’s backups are organized into a directory structure where all backups are stored under a
project's root backup directory.
<drive>\...\<root backup dir>
The project root directory can be specified by setting the "Root Save Folder" of the project's
properties. The root directory can be the same for all projects, or can be custom for a group
of projects (perhaps projects belonging to the same customer).
Under the root directory, robot backups are organized by projects. Usually, a project will
contain all the robots on a particular job. The root directory will have sub-directories for all the
projects you have created.
<drive>\...\<root backup dir>\<project>
Within the project directory, the robot backups can be organized in one of two ways.
There is the original structure where the backups are organized as follows:
<drive>\...\<robot backup dir>\<project>\<robot>\<date>\<time>[\FR]
This structure is the default structure and most advanced features are expecting this structure.
Or there is the Andy’s directory structure where the backups are organized as follows:
<drive>\...\<robot backup dir>\<project>\<date>\<time>\<robot>[\FR]
This structure is used when you want to organize the backups by date. The problem with this
structure is that it is not supported by some of the advanced features of ERBU (like "Manage
Backups").
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The directories above are referred to as the “dated” directories because each backup is stored
within a directory structure that contains the backup date in its name.
In addition to dated directories, ERBU creates a “Latest” backup directory. Every time a
backup occurs, the backup it stored in a dated directory. After the backup completes, the
dated directory is copied to a “Latest” directory. The contents of the “Latest” directory are
deleted before the new copy is made.
The “Latest” directory structure is organized as follows:
<drive>\...\<robot backup dir>\<project>\Latest\<robot>[\FR]
NOTE: The files in the Latest directory must not be open by any program when a backup is
made, otherwise the Latest directory cannot be cleared of old data and updated with new.
If configured to backup the robot’s flash ROM, ERBU will create a sub directory named “FR”
under the backup location. This is shown as the optional [\FR] directory in the directory
structures above.

1.11

MAIN WINDOW

The main screen is the window that is first displayed when ERBU starts. Below is a picture of
the main screen. When you are unsure of the function of something on any of the windows in
ERBU, you can hover your mouse over it for a short description of its function.
Callouts have been added to help you find related information below.
A
B

D

C

E

F
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A MAIN MENU

This menu bar that allows for basic access to files, configuration, utilities, and information.

B PROJECT TOOL BAR

This tool bar gives you the ability to add, delete, modify and filter projects.

C PROJECTS

ERBU organizes robots into projects. Each project should contain the robots for a particular
job. Before you can add robots, you must first create a project for them. On the main screen,
the left list box shows the projects you have created.
To create a project, click the “Add” button on the project tool bar. Each project name must be
unique and cannot contain special characters.
To delete a project, click the “Delete” button on the project tool bar. Deleting a project will not
delete any backups that were made under that project name.
To rename a project, change its associated folders, assign a network profile, or schedule an
automatic backup, click the “Properties” button on the project tool bar. Renaming a project
does not rename the project directory. This can cause Audit results to be inaccurate since it is
looking at the new project name, but previous backups were made under another name. If you
want to rename the project directory too, you will need to modify this using Windows.
To apply a filter to the project list, click the text box on the project tool bar and enter a filter.
This feature is useful for finding a specific project after the list has grown to a cumbersome
size. You can use the “*” wildcard character.
NOTE: When specifying a filter, the color of the text box will change colors indicating whether
or not a project matches the filter. White will indicate no filter, yellow will indicate a filter is
applied and results match, red will indicate a filter is applied with no matches found.

D ROBOT TOOL BAR

This tool bar gives you the ability to add, delete, modify, select and filter robots.

E ROBOTS

Once you have a project created, you can add robots to the project.
Before you add or modify a robot, be sure to select the desired project by clicking the project
name in the Projects list box. Once a project is selected, the robots already added to the
project will appear in the Robots list box.
To add a robot, click the “Add” button on the robot tool bar. Each robot name must be unique
and cannot contain special characters. Each robot must also have an IP address so ERBU
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knows where to connect. The IP addresses do not need to be unique; this allows you to back
up the same robot under different names like “R1_Before_Changes” and
“R1_After_Changes”. If you have chosen to verify a robot connection using the robot’s
identifier, then you have the option to supply the identifier when adding or editing a robot. For
FANUC robots, this is the robot's F number.
To delete a robot, click the “Delete” button on the robot tool bar. Deleting a robot will not
delete any backups that were made under that robot name.
To change a robot's brand, name, IP address or identifier, click the “Edit” button on the robot
tool bar.
All of the robots displayed in the Robot list box are eligible for backup. Each robot will have a
checkbox next to its name. If the robot’s checkbox is checked, this robot is selected for
backup. There are five methods for selecting robots for backup.


Left clicking the checkbox by the robot name in the Robot list box will toggle the robot
between selected and not selected.



Clicking the “Select All” button on the robot tool bar will select all the robots displayed
in the list ( ).



Clicking the “Deselect All” button on the robot tool bar will deselect all the robots
displayed in the list ( ).



Clicking the “Invert Selection” button on the robot tool bar will toggle selected robots to
deselected and toggle deselected robots to selected ( ).



Clicking the “Select Available” button on the robot tool bar will select the robot based
on the ping response of each robot in the project ( ). If a robot is available, it will
show a green circle indictor in the ping column, if it is not available it will have a red x
indicator.

To apply a filter to the robot list, click the text box on the robot tool bar and enter a filter. This
feature is useful for finding a specific robot in a project with a lot of robots. You can use the “*”
wildcard character. NOTE: Robots that are filtered out of the displayed list will not get backed
up. NOTE: The filter applies to all projects.
HINT: You can drag and drop files from Windows Explorer to this window. NOTE: Files
dropped here will be sent to the robot’s MD: after prompting for confirmation. The target of a
drag and drop operation depends on the settings in the Setup>Preferences menu. The
choices are to drop files to the highlighted robot or to the checked robot(s).

F BACKING UP SELECTED ROBOTS

To backup selected robots, click the “Backup” button below the Robot list box. If the button is
not enabled, check that at least one robot in the project is selected.
When a backup is started, the transfer window will be shown with a list of the selected robots.
For information on the Transfer window see section 1.21.
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NOTE: Starting in version 1.7.28, holding the SHIFT key when this button is clicked will force
ERBU to backup all files. This can be used to override the active file filters to backup
everything.
NOTE: Starting in version 3.0.64, you can assign keys to various file types in the backup
setup. Holding the key for a file type when the backup button is pressed will override the file
filters to backup the file type(s) associated with that key.
If the “Close when done” check box is checked, then ERBU will close when the transfer
completes.
The
button will restore the Transfer window and bring it to the front. This button is only
visible when the Transfer window is in use.
The current file type filters are shown on the lower left. They are shown for the various robot
brands. The filters can be overridden by the keys assigned to the file types in Setup>Backup
window.
LAUNCHING ERBU IN AUTONOMOUS MODE
ERBU has the option to be called from a DOS command line or batch file. If the name of the
project you want to backup is supplied as an argument, then ERBU will automatically try
backup all the selected robots in that project. The name of the project should not be
surrounded by quotes.
Example:
ERBU.exe 110330 – Good Customer
This will backup the selected robot in the “110330 – Good Customer” project.
This mode is useful for setting up regular automatic backups using the Windows Scheduled
Tasks program. You should not schedule backups too close together so that the previous
backup has time to complete. You can add a project for automatic backup, or check if it
already has one scheduled by checking the project's properties.
Prior to using this mode, it is important that the robots you want to be backed up are selected
so that ERBU knows which ones you want to backup when it starts.
In this mode, any robots that do not respond to a ping will automatically be skipped with no
notification. To determine if a previous backup was successful, you can audit the backup.
ERBU will automatically close when automatic backups complete.
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FILE MENU
The File menu has the following choices:
Explore Backups…
Explore Source Code…
Manage Backups…
Audit Backups…
Export Host config…
Import Host config…
Edit Database…
Edit INI File...
Exit

Explore Backups…
This choice will launch a Windows Explorer window pointing to the directory where all the
backups for the selected project are stored.
Explore Source Code…
This choice will launch a Windows Explorer window pointing to the directory that you have
setup as your source directory for the project. See section 1.17 for information on setting up
the source directory.
Manage Backups…
This choice will display the Backup Manger screen of ERBU. Backup Manager allows you to
view the history of backups, compare backups, archive backups and delete backups. See
section 1.12 for more information on using Backup Manager. This feature is not available in
early releases of ERBU 3.0.
Audit Backups…
This choice will display the Audit Backup screen of ERBU. Audit Backups allows you view the
status of the Latest backup directory. Many times, the Latest directory is used as a working
directory where changes can be made and then sent back out to the robot. To check the
integrity of the latest backup and to be sure it matches the dated directory, Audit Backups
should be used. See Section 1.13 for more information on using Audit Backups. This feature
is not available in early releases of ERBU 3.0.
Export Host config…
This choice allows you to save your robot configuration into formats that are compatible with
other applications. See section 1.14 for more information on exporting your setup.
Import Host config…
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This choice allows you to load in a robot configuration that was created by another application.
See section 1.15 for more information on exporting your setup.
Edit Database…
This choice allows you to open the robot database in Microsoft Access for external
modification. You will need to have Access installed to edit the database. It is typically
installed as part of Microsoft Office.
Edit INI File…
This choice allows you to open the ERBU configuration XML file for external modification.
Exit
Closes the application.

SETUP MENU
The Setup menu has the following choices:
Backup…
Preferences…
Network…
Auto Backup Scheduler…
Backup…
This choice will display the Backup Settings window which will allow you setup the behavior of
ERBU when backups are made. See section 1.16 for more information on setting up
backups.
Preferences…
This choice will display the General Settings windows which will allow you to setup different
aspects of ERBU. See section 1.17 for more information on general settings.
Network…
This choice will display an additional menu with the following choices:
Control Panel (Network)...
Control Panel (Firewall)…
WarPing...
Profiles...
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Control Panel (Network)...
This choice will launch the Network Connections item from the Windows Control Panel
allowing you to view or change network connections through Windows.
Control Panel (Firewall)…
This choice will launch the Windows Firewall item from the Windows Control Panel
allowing you to view or change network firewall settings through Windows.
WarPing...
This choice will launch the WarPing utility in ERBU. This utility allows you to discover IP
addresses on the network. For more information on WarPing see section 1.18.
Profiles...
This choice will display an additional menu with the following choices:

Your configured profile choices 

Manage...
This choice will launch the Network Profile Manager utility in ERBU. This utility
allows you to create network profiles that you can associate with your ERBU
projects. For more information on the Network Profile Manager see section 1.19.
<Profile Selections>
This area of the menu may not exist if you don't have any profiles defined. If you
do, this area will give you convenient access to your profiles and allow you
quickly set a profile by simply clicking on it from this menu.
Auto Backup Scheduler…
This choice will allow you to configure automatic scheduled backups using Windows Task
Scheduler. See Section 1.20 for details on using the Windows Task Scheduler.
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TOOLS MENU
The Tool menu contains utilities that you might find useful.
It has the following choices:
FANUC
Generic
Setup Windows Privileges (Windows 10 only)
Stopwatch…
Explore App.Path
Always on top drag and drop

FANUC
This menu choice contains useful utilities that are specific to FANUC robots. Choosing it will
display an additional menu with the following choices:

LS Line Renumbering
LS Indent of IF-ELSE-ENDIF’s
Remove IO States from LS files
Extract images from VD file
Make CM Files (CF)
Make INSTALL.CM (CF)
PMC Address Calculator…
Image Analyzer…
LS Line Renumbering

This choice will display options for renumbering the line numbers in an LS file. You
can choose to renumber the lines to be all 1’s or sequentially like 1,2,3…
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All 1’s
You might use the “All 1’s” option if you need to compare two LS files, and
would like the line numbers in both files to match. Having all 1’s will not
affect the loadability of the LS file into the robot controller.
Sequential
You might use the “Sequential” option if you’ve been editing an LS file and
you’d like the line numbers back in sequential order.
LS Indent of IF-ELSE-ENDIF’s

This choice will prompt you for a file or files (LS) that ERBU will open and correct the
indentation of IF-ELSE-ENDIF regions. This will make reading the LS file easier. See
below.
BEFORE:
236:

IF (R[348:Slow Spd]=0) THEN ;

237:

!High Speed ;

238:

IF (R[70:Override Speed]>75 AND R[66:TB Temp]>0) THEN ;

239:L PR[72:Place] max_speed CNT15 AP_LDR[36] TB R[66]sec,CALL GRP1_UCLMP_BG ;
240:

ELSE ;

241:L PR[72:Place] max_speed CNT15 AP_LDR[36]

;

242:

ENDIF ;

243:

ELSE ;

244:

!Slower Speed ;

245:

IF (R[70:Override Speed]>75 AND R[66:TB Temp]>0) THEN ;

246:L PR[72:Place] R[348:Slow Spd]mm/sec CNT15 AP_LDR[36] TB R[66]sec,CALL GRP1_UCLMP_BG ;
247:

ELSE ;

248:L PR[72:Place] R[348:Slow Spd]mm/sec CNT15 AP_LDR[36]
249:

ENDIF ;

250:

ENDIF ;

;

AFTER:
236:

IF (R[348:Slow Spd]=0) THEN ;
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237:

!High Speed ;

238:

IF (R[70:Override Speed]>75 AND R[66:TB Temp]>0) THEN ;

239:

L PR[72:Place] max_speed CNT15 AP_LDR[36] TB R[66]sec,CALL GRP1_UCLMP_BG ;

240:

ELSE ;

241:

L PR[72:Place] max_speed CNT15 AP_LDR[36]

242:
243:

;

ENDIF ;
ELSE ;

244:

!Slower Speed ;

245:

IF (R[70:Override Speed]>75 AND R[66:TB Temp]>0) THEN ;

246:

L PR[72:Place] R[348:Slow Spd]mm/sec CNT15 AP_LDR[36] TB R[66]sec,CALL GRP1_UCLMP_BG ;

247:

ELSE ;

248:

L PR[72:Place] R[348:Slow Spd]mm/sec CNT15 AP_LDR[36]

249:
250:

;

ENDIF ;
ENDIF ;

Remove IO States from LS files
This choice will prompt you for a file or files (LS) that ERBU will open and remove the
annoying IO states from a program. Like line numbers, these states also make it hard to
compare LS files.
BEFORE:
1:

DO[10:ON:Nest Req] ;

2:

GO[1:12:Fault] = 0 ;

3:

WAIT DI[10:OFF:Nest Req ACK] = ON ;

AFTER:
1:

DO[10:Nest Req] ;

2:

GO[1:Fault] = 0 ;

3:

WAIT DI[10:Nest Req ACK] = ON ;

Extract images from VD file
This is under development. It will extract images and other settings from a vision VD
binary file. Often the VDA does not contain all the information that the VD does.
Make CM files
This choice will display options for making a command files which can be used to copy
variable settings from one robot to another. This is sometimes necessary when a robot
have been upgraded and the system variable file will no longer load, or if specific
portions of data need to be copied and loading the entire system file might break other
settings.
NOTE: If your script generator setting is set to “CF” then the command will generate a
KCL compatible CF file rather than a CM file.
Two options are available:
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Template
From System File

Template
This will create a modifiable CM file with a bare bones example of the formatting
required to write values into the system variable values of a robot. The choice to
create a template file is not available for all system variables, however you can
use the From System File option to create a similar template with pre-populated
values.
NOTE: The output file gets created in the ERBU application directory. It will
overwrite any file located there by the same name.
From System File
This will prompt you for a file to extract system variables from. The file choices
will generally be filtered for the expected file types – there may be several valid

Page 28

ERBU User’s Manual
files since some variables used to be stored in the large SYSTEM.VA file before
later being separated into narrower focused files.
You will be prompted to browse for a system file on the local PC.
NOTE: In the future this may be smarter where only the folder will be prompted
and the files automatically chosen.
NOTE: The indicated output file gets created in the ERBU application directory.
It will overwrite any file located there by the same name.
Make INSTALL.CM
This tool will create a modifiable CM file that will set many system variables to their
preferred settings. This way you can customize settings in the CM file and then run it on
any robot as needed.
NOTE: The INSTALL.CM file will be located in the ERBU directory after it’s made, and
will be automatically sent to an editor.
NOTE: If your script generator setting is set to “CF” then the command will generate a
KCL compatible CF file rather than a CM file.

PMC Calculator
This tool will allow you to enter a PMC address get its robot equivalent I/O point and vice
versa. The calculator uses the default mapping.

Image Analyzer
Have you ever found a robot image on a USB or memory card and you don’t know what
robot it belongs to? In the olden days, you’d be out of luck, but now you can use the
Image Analyzer tool to extract some basic information from an image backup.
Information that can be used to help identify the robot it came from. You use the tool to
browse for a folder containing an image backup and the tool will analyze its contents and
provide a summary of its findings.
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It will also check this summary against known robots to try to determine which robot it
belongs to. The certainty increases with each matching piece of information. The MAC
Address matching will cause 100% certainty since it is globally unique to that robot.
The details tab will show the position register, number register and sysvar values that
were able to be extracted from the image.
Details Tab
The Details tab of the Image Analyzer will show whatever information can be detected.
The information that can be detected varies based on robot software version, so not all
information will be available.
Options Tab
This tab will show the options loaded on the robot. It should be noted, that this
detection is only reliable if the robot was installed from a single personality card. The
Copy button will copy the list of option to the clipboard. The Make BACKDATE
button will try to make a BACKDATE for import in to Roboguide. The BACKDATE is
not very reliable at the moment, especially for multi-group robots. The checkboxes
can be used to filter out libraries, options and core components.
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System Variable Tab
This tab will show the values of system variables on the robot. This seems to be
pretty reliable for most versions of software. It should be noted that STRUCTURE
variables are not exapanded since the contents of the structure are not known or
stored with the varaibles.
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Data Registers and Position Registers Tabs
These tabs will show the values of data and position registers. This is only working
for older robot software versions. In newer robot software, the location and format
was changed.
GENERIC
There aren’t any tools for Generic robots yet.
Setup Windows Privileges
This choice is only available for Windows 10 users. It will display a window that will
allow you to apply some tweaks to the Windows permissions to allow ERBU to run
more like it does in Windows 7.
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Stopwatch
This will open a stopwatch tool that can be used to time events such as robot cycle
times. The stopwatch tool behaves like any other stopwatch, but allows you to mark
times in a historical list allowing you to track sub-events.

This is the total running time of the stopwatch in seconds.
This is the total running time in minutes and seconds.
Start/Mark button will start the stopwatch and mark times.
Stop button will stop the running time.
The table will show a history of marked times and the delta
time from the previous mark.

Explore App.Path
Opens a Windows Explorer window to the folder where ERBU is running from.
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Always on top drag and drop
When selected, a small window will appear that is always visible. This window can be
used to drag files to ERBU much like you can with the main form. The advantage of this
window over the main window is that it’s very small, won’t get buried, and can be placed
at a convenient location on the screen.
Drag and drop files to this window.
To position the window, left click it and move it.
To close the window, deselect the option from the Tools menu.
HELP MENU
The Help menu has the following choices:
www.robotbackerupper.com
FANUC
ERBU User’s Manual...
About…

www.robotbackerupper.com
This choice will take you the webpage for Eric’s Robot Backer Upper.
FANUC
This choice will show an additional sub-menu:

The menu has the following choices:
Sysvars…
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Error Table Codes…
I/O Rack Numbers…
Robot Option Order Numbers…
Sysvars...
This choice will display a dialog showing some of the more common and
most forgotten system variables. This information is stored in the database
and is customizable and searchable. See section 1.22 for information on
how to use this.
Error Table Codes…
This will show the code numbers for various robot alarms so that you can add
them to the Error Table. This is useful if you have nuisance alarm messages
you want to suppress, but don’t know the proper code for the alarm to enter it
in the table.

I/O Rack Numbers…
This will show the rack numbers used to configure various types of IO. For
example, if you need to know the rack number to configure Ethernet IP then
the table would show you that it’s rack 89.
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Robot Option Order Numbers…
This will show you the numbers for many of the robot software options used
by FANUC. This is useful when ordering a robot to be sure it comes with the
correct options loaded. Also, when trying to determine what capabilities a
robot has when writing application software for it.

ERBU User’s Manual...
Displays this document.
About…
This choice will display the ERBU version information along with a disclaimer.
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The title bar of the about window will show the version of ERBU that you are
running. If you are running a DEMO version, the title bar will indicate it.

ROBOT RIGHT-CLICK POPUP MENU
The popup menu has the following choices:
Enable Advanced Features
Explore Latest…
Explore Source Code…
[Explore VR Path...]
Abort All and Deselect
Ping
Robot Homepage/Connect via HTTP
Connect via FTP
KCL via Telnet
SMON via Telnet
Launch RobotDemo...
Cycle Power
Synchronize Clock…
Run CF file locally
Put File to device…
Update File from device…
Bounce File to MD…
Image Backup/Restore…
Add a media backup…
Properties...
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The popup menu will appear anytime you right click a robot in the Robot list box. It will
provide access to some commonly needed utilities. The choices on the popup only apply to
the robot that was clicked. The menu options available vary depending on robot brand, virtual
versus real and whether or not advanced options are enabled.
Enable Advanced Features
This choice will toggle the less frequently used items on the popup on or off. When advanced
features are enabled, this menu item will have a checkmark beside it. Advanced features can
be set to either be disabled (grayed-out) or completely removed from the menu choices. The
setting of this behavior is done through the Setup>Preferences menu.
Explore Latest…
This choice will launch a Windows Explorer (or your preferred file explorer) window pointing to
the Latest backup directory for that robot.
Explore Source Code…
This choice will launch a Windows Explorer (or your preferred file explorer) window pointing to
the Source Code directory for that project. The Source Code directory is set in either the
robot or project properties.
Explore VR Path…
If the robot chosen is a virtual robot, this menu choice will launch a Windows Explorer (or your
preferred file explorer) window pointing to the virtual robot's path.
NOTE: This choice is only valid for FANUC virtual robots.
Abort All and Deselect
Often times, when sending a file to a robot it may be a file that you had been previously
editing on the teach pendant or is paused. When this is the case, you will be prevented from
sending the file. The error message given by the robot is "Program Already Exists".
Normally, you would have to walk to the robot and deselect it and/or abort it. This menu
choice will abort the currently running program and deselect all programs from the editor,
allowing you to send your file. You will be prompted to confirm your choice.
NOTE: This choice is only valid for FANUC robots.
Ping
This choice will ping the robot to determine if it is available on the network. A dialog box will
pop up indicating the results of the ping. This ping is a little different than the one used to
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show the availability indicators in the Robot list box. It has a longer timeout and more retries
than the Robot list box ping.
Robot Homepage
For non-FANUC robots, this menu item is labeled “Connect via HTTP”.
This choice will launch a web browser window pointing the robot’s main web page. It also has
a sub-menu that provides links to some of the more common FANUC webpages.

Current I/O page
This will navigate your web browser to the read-only robot webpage showing the current
IO state of the robot.
Numeric Registers page
This will navigate your web browser to the read-only robot webpage showing the current
number register state of the robot.
Position Registers page
This will navigate your web browser to the read-only robot webpage showing the current
position register state of the robot.
Comment Tool page
This will navigate your web browser to the read-write robot webpage showing the
comments of the various data types on the robot.
iRVision Runtime page
This choice will launch a web browser window pointing to the robot’s vision runtime
page.
NOTE: The robot must have the vision option installed for this menu item to be available.
The presence of the vision option is detected by ERBU using the properties page for the
robot.
NOTE: This choice is only valid for FANUC robots.

Page 39

ERBU User’s Manual
iRVision Setup page
This choice will launch your web browser window pointing to the robot’s vision setup
page.
NOTE: The robot must have the vision option installed for this menu item to be available.
The presence of the vision option is detected by ERBU using the properties page for the
robot.
NOTE: This choice is only valid for FANUC robots.
Manage Links
This is still in development and will allow users to add their own bookmarks to various
robot webpages.
Connect via FTP
This choice will launch FTP session to the robot. The default client is the DOS command line
FTP client. Some other clients are more feature-filled and maybe preferred over the DOS
version. The FTP client used depends on your settings in Setup>Preferences.
KCL via Telnet
This choice will launch a Telnet session to the robot. The default Telnet client is the DOS
command line Telnet client. Some other clients are more feature-filled and maybe preferred
over the DOS version. The Telnet client used depends on your settings in
Setup>Preferences. A good alternative to the DOS version is PowerTerm. If using
PowerTerm, you will automatically log in as a KCL user. Auto-login is only available if
PowerTerm is your chosen terminal program.
NOTE: Starting in version 1.7.16 the PowerTerm command line now includes PTDEF.PTS so
user preferences are maintained.
NOTE: This choice is only valid for FANUC robots.
SMON via Telnet
This choice will launch a Telnet session to the robot. The default Telnet client is the DOS
command line Telnet client. Some other clients are more feature-filled and maybe preferred
over the DOS version. The Telnet client used depends on your settings in
Setup>Preferences. A good alternative to the DOS version is PowerTerm. If using
PowerTerm, you will automatically log in as a SMON user. You must know the password to
login to SMON. Auto-login is only available if PowerTerm is your chosen terminal program.
NOTE: Starting in version 1.7.16 the PowerTerm command line now includes PTDEF.PTS so
user preferences are maintained.
NOTE: Unless using PowerTerm, there is no difference between how the KCL and SMON
sessions are started by ERBU.
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NOTE: This choice is only valid for FANUC robots.
Launch RobotDemo
This choice will launch the RobotDemo application that comes with FANUC’s PCDK software.
Unless you are using the modified version of RobotDemo, you will need to connect to the
robot manually once RobotDemo launches. If you are using the modified/simplified version,
then the connection will automatically be made to the correct robot.
NOTE: This choice is only valid for FANUC robots.
NOTE: This choice is only available if FANUC’s RobotDemo program is installed.
Cycle Power
This choice will cycle power on the robot. A dialog prompting you to confirm will be displayed.
No checks are done to ensure the robot teach pendant is enabled or that the robot is not
running.
NOTE: This choice is only valid for FANUC robots.
Synchronize Clock
This choice allows you set the robot’s clock to match the clock on the computer that is doing
the backups. This is a good idea if you want to use the robot clock to verify program modify
times. See section 1.24 for information on synchronizing clocks.
Run CF file locally…
Often it is necessary to run a CF file to set system variables or do other KCL tasks. Doing this
on the robot requires a CF file to be on the flash ROM or on a Memory Card. “Run CF
locally...” allows you to run a CF file from your computer without making a copy on the robot.
Clicking this will display a sub-menu with choices for running CF files:
Manually…
<CF file shortcuts>
Manage…

Manually…
This choice will prompt you to choose a CF file that is located somewhere on the
local computer. Once chosen, a window showing a local KCL command
interpreter. See section 1.23 for information on using the Run CF file locally.
NOTE: This choice is only valid for FANUC robots.
NOTE: This choice is considered an advanced feature.
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<CF file shortcuts>
If there are any items listed with a
icon beside them, then they are
shortcuts. When a shortcut is selected it will run the indicated CF file
automatically to that robot. To add shortcuts to this list, use the Manage choice
shown below.
Manage…
This choice will display the following dialog.

You can use this dialog to execute or edit CF files or add them as shortcuts to the
“Run CF locally…” robot popup menu.
All CF files detected in the ERBU directory will be listed in this dialog. You cannot
point this to another directory.
To execute a CF file in the list, select (highlight) it and click the Execute button.
To edit a CF in the list, select (highlight) it and click the Execute button.
To add a CF file in the list to the shortcut list, check the checkbox next to the CF
name.
NOTE: The CF file’s visibility on the shortcut list is controlled by an extra line
added to the top of the CF file. -- ERBU.List:1
Put file to device…
MD:
This option will allow you to choose a file to send to the robot’s flash Memory Device.
Multi-file selection is valid from this dialog
NOTE: This choice is only valid for FANUC robots.
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NOTE: A quicker alternative to this is to drag files to the robot list. The downside is you
must have the robot(s) you want to send files to pre-selected.
FR:
This option will allow you to choose a file to send to the robot’s flash ROM. Multi-file
selection is valid from this dialog.
NOTE: This choice is only valid for FANUC robots.
Update File from device…
MD:
This will allow you to specify a file on your PC that you want to get (update) from the robot.
After you specify the file, ERBU will request a file of the same name from the robot. If the
file exists on the robot MD, the file you specified will be overwritten with the copy from the
robot.
NOTE: This choice is only valid for FANUC robots.
NOTE: The file you specify does not need to exist locally for choosing, you can simply type
the name of a file that does not exist.
FR:
This will allow you to specify a file on your PC that you want to get (update) from the robot.
After you specify the file, ERBU will request a file of the same name from the robot. If the
file exists on the robot FR, the file you specified will be overwritten with the copy from the
robot.
NOTE: This choice is only valid for FANUC robots.
NOTE: The file you specify does not need to exist locally for choosing, you can simply type
the name of a file that does not exist.
Bounce File to MD…
This will allow you to put a file to MD and then immediately get the file back from the robot.
This is handy when you want to use the robot to fix the line numbering in an LS file.
NOTE: This choice is only valid for FANUC robots.
Image Backup/Restore…
Backup…
This will allow you to do an image backup of the robot.
For image backups, follow these guidelines:
1) It should not be used to replace image backups to memory cards.
2) Do not try to do images on more than one robot at a time.

Page 43

ERBU User’s Manual
3) Make absolutely sure you are backing up the correct robot since you will not be able to
identify the source robot after the backup is made.
NOTE: Starting in 3.0.74 you can extract some basic information from robot images
using Tools>FANUC>Image Analyzer
4) Be sure to have enough storage space on the backup drive to hold the backup.
5) You cannot make image backups of virtual robots.
NOTE: Just like a memory card image, this option requires the robot to power down.
NOTE: Currently an ERBU image backup is faster than a USB image backup, but slower
than a memory card image backup.
See section 1.25 for information on how to make an image backup.
Restore…
This will allow you to do an image backup of the robot.
For image backups, follow these guidelines:
1) Be sure the size of the image matches the robot memory size.
2) Do not try to restore images on more than one robot at a time.
3) Images are only restorable on robots similar to the source robot.
4) You cannot restore images to virtual robots.
NOTE: Just like a memory card image, this option requires the robot to power down.
NOTE: Currently an ERBU image backup is faster than a USB image backup, but slower
than a memory card image backup.
See section 1.25 for information on how to make an image backup
Properties...
This will allow you edit properties of the robot. These properties include:
 Robot Brand
 Robot Name
 Robot IP Address
 Robot Identifier (F Number for FANUC’s)
 Software version (FANUC robots only)
 iRVision presence (FANUC robots only)
 Robot MAC Address
 Source Code Folder (FANUC robots only)
 FTP Credentials – this can be detected from (FANUC) virtual robots.
 KCL Credentials (FANUC robots only)
 Post backup script
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1.12

MANAGE BACKUPS WINDOW

The Manage Backups screen provides some basic tools for managing your backups.
The Manage Backups screen is displayed by choosing “Manage Backups…” from the File
drop down menu on the main screen.
NOTE: Depending on the number of robots and backups, the overview screen may take a
while to load.
NOTE: Only backups made using the original backup directory structure can be managed
using Manage Backups.
NOTE: Backup manaer does not track backups. It only reports backups it finds under the root
backup directory.
Below is a picture of the Backup Overview screen. When you are unsure of the function of
something on any of the windows in ERBU, hover your mouse over it for a short description of
its function.
There are two tabs on the overview screen, Compare and General. The picture and
descriptions below are for the Compare tab.
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COMPARE TAB

B

A
D

C

D

F

E

Callouts have been added to help you find related information below.
A

ROBOT LIST

This area shows the robots that belong to the project being viewed. The list of robots on this
screen should match the one on the main screen. If a filter is applied on the main screen, it
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will be applied here as well. If no backups have been made for this project, no robots will be
listed.
Source
This item in the list is only visible if Absolute Mode is chosen for the compare type. Double
clicking (or right-clicking) it will allow you to choose a non-backup directory to include in the
compare (such as the source directory). Its icon is shown as a Windows folder.
Robots
The project robots will be displayed here. If there are no robots in the robot list on the main
screen, then this list will be empty also. If the robot icon shows a plus next to it, then this
robot has backups that can be displayed by clicking the robot icon or name. If the robot icon
shows a minus next to it, then the backups for this robot are being displayed and can be
hidden by clicking the robot icon or name. Right clicking will bring up this menu.

Add a media backup…
This will allow you to add a backup from a USB or memory card into the ERBU backup
folder structure. You will be prompted for a folder to add. When adding the backup,
ERBU will determine when the backup was made and then prompt you to confirm the
destination folder for the backup. It will then copy the media backup into the proper
location. If the media backup is newer than the ‘Latest’ backup, you will also be prompted
to copy the media back to the latest backup too. After adding, the backup will appear in
the list of backups beneath the robot it was added to.
If the backup you are adding is a FANUC robot image, then ERBU will detect this and
prompt you to confirm the copy destination folder, but the backup will not appear in the list
of backups beneath the robot it was added to.
Explore Backups…
This is only available when the backup directory structure is set to normal (not Andy’s).
Clicking this will open a Windows Explorer window in the backup location for this robot.
Explore Images…
This is only available when the backup directory structure is set to normal (not Andy’s).
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Clicking this will open a Windows Explorer window in the image backup location for this
robot.
Backups
The robot backups are displayed with their date and time and a 3½” floppy diskette icon.
Right clicking a backup will display a popup menu. Depending on the compare type chosen,
the popup will display different options.
Absolute Mode

Relative Mode

Set As Master Backup
This choice will set the selected backup as the Master Backup meaning that all Compare
Backups will be compared to it. There can only be one Master Backup for comparisons. If
you choose another backup to be the Master Backup, the first Master Backup will be
cleared. You can also set the Source directory as a Master. Master Backups will be
displayed with a golden padlock icon.
This choice is only available in Absolute Mode.
Set As Compare Backup
This choice will set the selected backup as a Compare Backup meaning that it will be
compared to the Master Backup. There can be as many Compare Backups as you want
and they can span across multiple robots. You can also set the Source directory as a
Compare. Compare Backups will be displayed with a silver padlock icon.
This choice is only available in Absolute Mode.
Set As Relative Origin
This choice will set the selected backup as the starting point for a relative compare. A
relative compare will start at the origin and treat that backup like a master backup and the
subsequent backup as a compare backup. After comparing those two backups, it will then
set the compare backup to be the next master backup and its subsequent backup as the
next compare backup. This technique is repeated for all subsequent backups. There can
be only one Relative Origin and relative compares cannot be made across multiple robots.
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Relative compares cannot include the Source directory. The Relative Origin will be
displayed with a golden padlock icon.
This choice is only available in Relative Mode.
Clear
This choice will remove the Master, Compare or Origin status of a backup. The backup
will be displayed again with a 3½” diskette icon.
Copy List to Clipboard
This choice is only available after a compare has been made and differences are being
displayed under the backup. Choosing this will copy the list of different files to the
Windows clipboard where the list can be shared with other applications.
Explore Backup…
This choice will launch a Windows Explorer window pointing to the directory for the
selected robot backup.
Archive Backup…
This choice will archive the backup into a compressed (zipped) folder. If you have chosen
to automatically delete backups after they have been archived, the backup will no longer
be available for comparison. After archiving, the backup will be displayed in the overview
with a WinZip icon so that when archiving many backups, you can see which ones have
already been done. However, after the overview window is closed, the archived backups
will not appear in the overview next time it is opened.
Archived files will be named in the following format:
<robotname>^<backupdate>^<backuptime>.zip
The location of the archived file can be specified from the General tab.
NOTE: You can set ERBU to delete backups after they have been archived by choosing
that option from the General Tab. The archive will be checked for integrity before the
backup is deleted.
Delete Backup
This will delete the backup.
Properties
This will show the backup date/time, its location, the devices backed up, the file counts,
and the archive status of the robot backup.
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B

COMPARE TYPES

There are two ways ERBU can compare backups.
Absolute Mode
In this mode you can compare a single “Master” backup to many other backups to determine
what flies are different between the backups.
The “Master” backup is chosen by right clicking a backup and setting it to be the master. The
master backup is always compared to all of the chosen “Compare” backups. The “Compare”
backups are chosen by right clicking backups and setting them to be compares.
There can only be one master. There can be as many compare backups as you choose. The
Source directory can be set to either a master or a compare.
NOTE: The more backups you choose to compare, the longer the comparison will take.
The master backup is displayed with a golden padlock icon and its text will be bold. The
compare backups are displayed with silver padlock icons.
After a master backup and at least one compare backup and a file type have been chosen,
the “Compare’ button will be enabled.
Example:

Each compare backup is
compared to the master
backup

In the above example, the backup 03/05/2010 08:08:18 is set as the master backup. The
backups 03/05/2010 08:58:06 and 03/11/2010 15:12:43 are both set to compare backups.
When a comparison is made, both compare backups are compared independently to the
master backup. The files that are different will be displayed under the compare backups.
Relative Mode
In this mode you can compare many backups to its subsequent backup to determine what
files changed over time.
The starting point of the comparison is set by choosing the “Relative Origin”. All backups after
the origin will be included in a comparison, so this compare can take a long time depending on
how many backups come after the origin.
The origin backup is displayed with a golden padlock icon and its text will be bold.
After a relative origin and a file type have been chosen, the “Compare’ button will be enabled.
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Example:

Each backup is compared
relative to the previous
backup

In the above example, the backup 04/08/2010 08:06:42 is set as the relative origin. All
backups made after the origin backup will be compared to its immediate predecessor. The
backup 04/09/2010 09:47:04 backup will be compared to the origin backup. The 04/12/2010
07:39:24 backup will be compared to the 04/09/2010 09:47:04 backup.
The Latest directory is not included in a relative comparison since its dated directory is already
included. The files that are different will be displayed under the compare backups.
HINT: It may be easiest to think about Relative Mode as an Absolute Mode where the master
backup moves between compares. The master will always be the earlier of the two backups.
C

FILE TYPES

This area of the screen is used to choose what file types will be included in a compare. Only
selected file types will be compared. The icons above this area provide ways to select all,
deselect all, and invert your selection.
D

COMPARISON SETTINGS

This area allows you to customize the behavior of the compare algorithm.
Check for missing files
This choice will cause the compare algorithm to check for files that are in the master backup
but are missing from the compare backup. Missing files will be displayed with a special icon
( ) in the list of different files.
Check for extra files
This choice will cause the compare algorithm to check for files that are in the compare backup
but are missing from the master backup. Extra files will be displayed with a special icon ( )
in the list of different files.
Check for different files
This choice will cause the compare algorithm to check files for differences. By default all files
are compared using a binary compare using these rules:
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1) Check if files are different files sizes as reported by Windows. If they are, the files are
different.
2) If the Windows file sizes match, compare the files byte-by-byte to see if every byte is the
same. If a single byte doesn’t match, the files are different.
Files that fail the binary check are displayed with a special icon (

) in the list of different files.

Optionally, you can choose to do a text compare on LS files by choosing “Use smart compare
on LS files”. Files that fail the text compare are displayed with a special icon ( ) in the list of
different files.
Use smart compare for LS files
LS files are typically files that contain robot programs. These files can be modified on the
robot. One program might be a different size from another but may be logically identical. An
example of this would be when a blank line is added; it does not change the functionality but
the file is in fact modified.
The purpose of this choice is to supply a text compare that is smart enough to ignore many of
the things that make LS files different when we really only care if they are logically different.
One of the main items that cause LS files to be different is the line numbering. Simply adding
a blank line to the top of a program will cause all the line numbers to be different. When smart
compare is chosen, the line numbering is automatically ignored.
Only
When this option is chosen only program LS files are compared. Non-program LS files
(errhist, erract, etc.) will not be compared.
Include header
The program header is another item that can cause differences in LS files which might be
irrelevant. The header is considered to be the part of the program between “/PROG” and
“/MN”. By default, the header is excluded from comparisons. By choosing this option, you can
include it.
Include positional data
Rarely will two programs have the same exact positions stored in them. For this reason, the
positional data is excluded from compares by default. By choosing this option, you can
include it. The positional data is considered to be the part of the program between “/POS” and
“/END”.
Include comments
Comments are the parts of the program that really make no logical difference to the way the
program performs, but they play an important role in helping operators follow the code. It is
usually helpful to make sure that programs that do identical tasks have up to date, non-
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conflicting comments. Since they have no impact logically to the program, they are excluded
by default. By choosing this option, you can check for differences in the comments.
Comments to ERBU are remarks in TP language.
Include descriptors
Descriptors are another part of the program that don’t affect the way the programs perform but
they are important for troubleshooting reasons. Since they have no impact logically to the
program, they are excluded by default. By choosing this option, you can check for differences
in the descriptors. Descriptors to ERBU are comments in TP language and can be turn off on
the teach pendant.
E

COMPARING

When your choices for which backups to compare are valid, the “Compare” button will become
enabled. After clicking the compare button, ERBU will carry out the compare and display a
dialog box showing a summary of the results.

NOTE: Depending on the number of backups, the file types and settings chosen the compare
can take a while.
Once you acknowledge the summary dialog box, you will notice the results of the compare
show up under the compared backups. The files that matched the compare criteria will be
listed. Below is an image showing an example of what the robot list might look like after a
compare.
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After you acknowledge the summary dialog, the results are kept in a list below the Robot list.
This way you can keep a history of your compare results. To clear this history, double click
the history list.
Depending on the type of files compared, you can right click the files to bring up a popup
menu that will allow you additional options for the file. Below is an image showing what
options are available when right clicking an LS file.
F

HISTORY

This area will keep a history of the results of the compares you have done. Double click to
clear the history.
POPUP MENU
The popup menu for compare results has the following choices:
Show Differences
View in Editor (raw)
View in Editor (cleaned)
Properties
Show Differences
This choice will only be available if you’ve set up a compare program on the General tab
page.
This choice will send both the master and compare files to the compare program to have set
up.
View in Editor (raw)…
When this option is chosen it will open the original master and compare files with your default
text editor for that file type. If you are using Multi Edit, both files will be opened in the same
session for easy comparison.
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View in Editor (cleaned)…
When this option is chosen it will open the cleaned up master and compare files with your
default text editor for that file type. If you are using Multi Edit, both files will be opened in the
same session for easy comparison. Currently these files are created in your temp directory
and are named “master_<filename>.ls” and “compare_<filename>.ls”.
“Cleaned” refers to the state of the file after all the line numbers, and other excluded text have
been removed by a smart compare.
Properties
Shows the Windows file properties.
GENERAL TAB
This tab allows you to setup general preferences for the Backup Overview screen. Below is a
picture of the choices available on the General Tab.

Delete backup after archiving
This option will cause ERBU to automatically delete a backup once it has been archived. The
zip file will be checked for integrity before the backup is deleted. Once deleted, the backup
will no longer appear in the backup list when the overview window is opened.
Auto clear on robot node collapse
This option will cause ERBU to clear the status of any master or compare backups that were
present in the backups for a robot whose tree node was collapsed.
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Archive Destination
This option will allow you to choose where the archived zip files get saved.
Choosing project folder will save the archive in the project folder containing the robot.
Choosing robot folder will save the archive in the robot folder where the backup was located.
Compression Program
Clicking this link will allow you to set the compression program you prefer to use for you
archives. If left blank, the built-in windows folder compressor will be used.
Supported programs include: WinRar, WinZip, 7Zip, and the Windows built-in.
Compare Program
Clicking this link will allow you to set the compare utility you prefer to use. If left blank, you will
lose the ability to “Show Differences” after a file compare.
Supported programs include: WinMerge, ExamDiff, Beyond Compare 3. Others may work,
but have not been tested.
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1.13

AUDIT BACKUP WINDOW

The Audit Backup screen allows you to check the status of the latest backup.
The Audit Backup screen is displayed by choosing “Audit Backups…” from the File drop down
menu on the main screen. NOTE: Depending on the number of robots being audited, the
audit screen may take a while to load.
The idea behind auditing is to determine if the last backup retrieved all of the files that you
requested and that the files haven't been modified locally.
Below is a picture of the Audit Backup screen.

E

A

B

C

D

Callouts have been added to help you find related information below.
The audit screen will populate a list box with all of the robots from the selected project.
NOTE: If there is a filter applied to the robot list on the main screen, the filter will also apply to
the robot list on the audit screen. A note in the title of the window will alert you to this.
The list box is split into columns to organize the backup information. The information
displayed in each column and how to interpret it follows:
A

ROBOT NAME

This column shows the robots that belong to the project being audited. The list of robots on
this screen should match the one on the main screen. If a filter is applied on the main screen,
it will be applied here as well.

B

DATE

This is the date of the last backup. If no backup has been made for this robot, this field will be
blank. The date of the backup is determined by different sources in this order:
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1) From the date written inside of “ftp.log” (early ftp.log files did not have the date included)
2) If an “ftp.log” file exists, but no date is written in it, the Windows timestamp for the “ftp.log”
file is used.
3) If no “ftp.log” file exists, then the Windows timestamp for “backdate.dt” is used
4) If no “backdate.dt” file is found, the date is considered unknown and the date field for that
backup is left blank. NOTE: The date inside of “backdate.dt” is not used since it uses the
robot clock which may not be correct.
C

FILE COUNT

The number of files is determined by reading the “ftp.log” file.
ERBU requests a list of all of the files on the robot and then determines how many of each
requested type exists on the robot.
EXAMPLE:
1) ERBU requests “dir *.*" from the robot
2) The robot sends a directory listing to ERBU
3) ERBU determines which type of files the user wants (*.ls, *.vr, etc.)
4) ERBU determines the expected file count by determining how many files on the robot are
of a type the user wants
5) ERBU writes the expected file count to “ftp.log”
The File Count column will show the number of files counted in the Latest directory along with
how many files were expected. If the expected number of files shown in “ftp.log” matches the
number of files in the directory, then the backup is considered a success. NOTE: The “ftp.log”
and “notes.txt” files are not counted, neither are files that begin with "!Fc" or "!ERROR."

D

BACKUP STATUS

The purpose of this column is to show the status of the last backup. This column will have a
note on the reason the backup is in a certain state. There are three main states the backup
can be in:
SUCCESS – A backup has been made and the expected file count in “ftp.log” matches the
actual file count in the Latest directory. Also, the Latest directory has not been
modified and matches its dated directory.
Successful backups will have a green check mark icon preceding the robot
name.
UNKNOWN – A backup has been made, but it cannot be determined if all of the files were
backed up. Or, the Latest directory has been modified and it no longer
matches the dated directory. This is common the Latest directory is used as a
working directory for robot changes.
Unknown backups will be indicated with an orange question mark icon.
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FAILED –

A backup has not been made or the robot was skipped during the last backup.
Failed backups are indicated with a red exclamation point icon.

It is often useful to use the Latest directory as a working directory for robot changes. This is
especially true when operators have made changes to programs causing your source code to
be obsolete. One of the key features is to detect when the Latest directory is not synched with
its dated directory.
The techniques used for detecting differences are detailed below:
There is a compare at the end of the audit that will compare the contents of the "Latest"
directory with the contents of the dated backup directory where the latest files were originally
downloaded.
E

COLORS, INDICATORS AND OVERALL STATUS

Backups that are known failures are indicated by a red exclamation point icon.
Backups that are questionable are indicated by an orange question mark icon.
Backups that are definitely good are indicated by a green check mark icon.
The total of each type of backup is shown above the robot list. Good count shows the total
number of successful backups. Bad count shows the total number of failed backups. Ugly
count shows the total number of questionable backups.
If there is a filter applied to the robot list, a note will appear in the title of the window showing
this.

1.14

EXPORT HOST CONFIG WINDOW

The Export Host Config window allows you to save the robot names and IP addresses into a
file format that is recognized by other applications.
The Export Host Config screen is displayed by choosing “Export host config…” from the File
drop down menu on the main screen.
Below is a picture of the Export Host Config screen.
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EXPORT TO WINDOWS HOSTS FILE
The Windows HOSTS file is a file that is used to associate a name to a computer IP address.
This allows you to use an easy to remember name in place of a hard to remember IP address.
When you use the name, Windows will look up the corresponding IP address to determine
where to connect.
NOTE: The HOSTS file is located in the %SYSTEMROOT%\system32\drivers\etc directory.
Normally %SYSTEMROOT% = “C:\WINDOWS”.
This export option allows you to add the robot names and IP addresses to the HOSTS file. To
export to the HOSTS file, make sure this option is selected and then click the “Export” button.
After it exports, a dialog box will popup allowing you to view the export results. If a robot with
the same name already exists in the HOSTS file, you will be prompted to overwrite or append
the definition.
NOTE: Only the robots of the selected project will be added, and all robots will be added
regardless of whether or not they are selected.
The "View" link to the right of this option will open the HOSTS file in the default editor so that
you can view the current contents.
NOTE: Many antivirus software packages prevent the HOSTS file from being modified. If this
is the case, you will need to disable this protection to export to the HOSTS file.
EXPORT TO ANOTHER ERBU USER
This option allows you share your robot list with another ERBU user. To export to another
ERBU user, make sure this option is selected and then click the “Export” button. After it
exports, a dialog box will popup allowing you to view the export results. The export will create
a file with a name matching the project name with an “.out” file extension. The file will be
created in the same directory as the ERBU executable.
Older versions of ERBU did not have the ability to store robot identifiers in the ERBU
database. To make the exports compatible with the older imports, the identifiers are not
included nor are the brands.
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EXPORT TO POWERTREM INI FILE
This option allows you to export your robot list to a file that can be used to populate the
Sessions List in PowerTerm with the names and IP addresses of your robots. When you
select the option to export to a PowerTerm INI file, the text box below this option will become
enabled. Here you can set a location where the INI file will be created. You can type the
location in the text box, choose the PowerTerm directory or browse to any other directory.
To export to a PowerTerm INI file, make sure this option is selected and then click the “Export”
button. After it exports, a dialog box will popup allowing you to view the export results.
PowerTerm uses a file named PTCOMM.INI to configure itself on startup. One thing that gets
configured is the Sessions List. When ERBU exports to an INI file it will create a file with the
project name followed by “_PTCOMM” and a “.INI” file extension. If you want to use it as your
PowerTerm config file, you will need to rename it to “PTCOMM.INI” and move it to the
PowerTerm folder. This step is there so that you have a chance to merge configurations if
you want to.

1.15

IMPORT HOST CONFIG WINDOW

The Import Host Config screen allows you to load robot names and IP addresses from a file
format that is used by other applications.
The Import Host Config screen is displayed by choosing “Import host config…” from the File
drop down menu on the main screen.
Below is a picture of the Import Host Config screen.

Currently the only import method that is supported is the “Import from another ERBU user”
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IMPORT FROM ANOTHER ERBU USER
This option allows you to load robot names and IP addresses from an export file created by
ERBU.
NOTE: Future versions of ERBU will allow you to exchange this information over a network
without the need to create a file.
To import from another ERBU user, make sure this option is selected and then click the
“Import” button. A dialog box will appear allowing you to browse for the file to import. Once
you choose the file, ERBU will add the robots found in the import file to the currently selected
project or a new project (depending on the destination chosen). If a robot with the same name
already exists, it will not be added.
IMPORTANT: If you're importing to an existing project, be sure you've already selected the
project where you want the robots added. If you fail to do this, you will be adding robots to the
wrong project. ERBU does not check that the import filename matches the project name.
It is possible to manually create an import file. The format is:
<robotname1> , <IPaddress1>
<robotname2> , <IPaddress2>
…
The default file extension is “.out”.
Destination
There are two places that robots can be imported to; an existing project or a new one. Where
the robots go depends on your choice of destination.
Import to the current project
This will import the robots to the project you had selected before entering the import
screen. You can tell which project is selected by looking at the title of the import
window.
Import to a new project using the name of the import file
This will prompt you to create a new project using the name of the import file for the
name of the project. The imported robots will be added to this new project.

1.16

BACKUP SETTINGS WINDOW

The Backup Settings screen allows you setup the behavior of ERBU when backups are made.
The Backup Settings screen is displayed by choosing “Backup…” from the Setup drop down
menu on the main screen.
Below is a picture of the Backup Settings screen. You might notice that there are brand
specific settings shown. In future releases, this screen will be modified to change setting
choices based on the brand chosen (similar to how the file types list works).
Any choices you make on this screen will apply to all backups and are not project specific.
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A
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E

Callouts have been added to help you find related information below.
A

BACKUP CONNECTION TYPE

There are three ways ERBU can connect to the robots to do backups.
Shotgun
In this mode, ERBU will connect to all selected robot simultaneously and back them all up
at once. This is the fastest and preferred method.
Sequential
In this mode, ERBU will connect to each robot one at a time and when that robot finishes,
it will connect to the next.
NOTE: If a sequential backup is started, additional backups that are started concurrently
will not be sequential with previous batches. It is treated as an independent backup.
Batches of X
In this mode, ERBU will simultaneously backup batches of robots. As robots finish
backing up, pending backups will start, but the number of simultaneous connections will
not exceed the batch size specified. This mode is good for backing up a large number of
robots without straining the network.
NOTE: If a batch backup is started, additional backups that are started concurrently will
not be managed as part of previous batches. It is treated as an independent backup.
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B

BACKUP PATH DIRECTORY STRUCTURE OPTIONS

These options allow you to specify one of the two layouts allowed for building the paths for the
dated backup directories.
Use original backup structure
This option will cause ERBU to use the original backup directory structure when creating
the directories for backups. See section 1.10 for details.
NOTE: This layout uses <root>\<robot>\<date>\<time>\ for the dated directory path.
Use Andy’s backup structure
This option will cause ERBU to use Andy’s backup directory structure when creating the
directories for backups. See section 1.10 for details.
NOTE: This layout uses <root>\<date>\<time>\<robot>\ for the dated directory path.
C

BACKUP PREREQUISITES

These set the requirements for the backup that must be set prior to doing the backup.
Suppress TP comments
This option will force ERBU to connect to the robot and disable the comments in the teach
pendant programs prior to doing a backup. This is effectively the same as choosing the
“Comment” option from the [EDCMD] menu in the robot teach pendant editor. This is
useful for loading programs back into robots that have been setup to adopt comments
from uploaded programs where you might not want this to happen.
NOTE: This option requires the PC Interface option to be loaded on the robot.
Authenticate robot by identifier
This option will force ERBU to connect to the robot and verify the robot’s identifier (F
number on FANUC robots($FNO system variable)) matches the one setup in ERBU prior
to backing up the robot. If they don’t match you will be prompted for action (unless in
autonomous mode, then it will be skipped).
Retry –

This option allows you to correct the cause of the problem and then retry.

Cancel –

This option allows you to cancel the backup so that you can correct it
later.

NOTE: This is not supported for virtual robots, since it's not very often that F Number is
setup for them.
NOTE: This option requires the PC Interface option to be loaded on the robot.
Authenticate robot by MAC Address
This option will force ERBU to ARP the robot and verify that the robot’s MAC Address
matches the one setup in ERBU prior to backing up the robot. If they don’t match you will
be prompted for action (unless in autonomous mode, then it will be skipped).
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Retry –

This option allows you to correct the cause of the problem and then retry.

Cancel –

This option allows you to cancel the backup so that you can correct it
later.

NOTE: This is not supported for virtual robots, since the MAC address is not usually setup
or is the same as the host PC.
NOTE: ARP is a network protocol used to get the physical hardware address of a network
node. The robot does not require PC Interface to use this option, but some networks may
not allow ARP.
Keep canceled backups
This option (currently always enabled), keeps the backup from automatically being deleted if it
gets canceled by the user.
Automatically load dictionary files
If a .TX file is sent to the robot, the file will get copied to the FR regardless of the original
intended destination. After being copied to FR, the file will be loaded as a dictionary. This
option isn’t really a backup option so maybe it will be moved to the preferences window.
Use faster listings
With this selected, the robot will request directory listings from the robot over HTTP rather
than FTP, which provides a faster response.
NOTE: The HTTP access must be unlocked on the robot for this to work.
D

BACKUP SOURCES

This option allows you to choose what memory will be backed up on the robot.
MD:
Selecting MD: will cause ERBU to back up the robot Memory Device. This is where the
working files of the robot are kept.
FR:
In addition to backing up files on MD, you can backup the files on the robot flash ROM.
This memory area can be used to hold data files, vision files, copies of programs, etc.
When this is selected for backup, a subdirectory is made in the normal robot backup
location named “FR”. NOTE: This will currently only backup files at the root level.
Include Subdirectories:
This is currently not supported. It was on previous versions of ERBU, but was very slow.
When implemented it will recursively change subdirectories on the flash ROM and back
them up as well. Current backups only grab files at the root of FR.
Manage…
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This link will allow you to customize what devices are shown in the Backup Sources.

E

FILE TRANSFER MANAGER

This link will launch the options window that is normally only accessible when the transfer
window is open.

F

FILE TYPE TOOLBAR

This tool bar gives you the ability to add, delete, modify and select file types.
G BACKUP FILE TYPES LIST

This area of the screen is used to choose what file types will be backed up. Only selected file
types will be backed up. The file types can be added based on robot brand. If a robot is
specified to belong to a brand, then the corresponding list will be used to determine what file
types should get backed up. You can change the list to other brands by selecting the brand
from the tabs at the top of the list. To choose a file type for backup, click the check box next
to the file type you want to back up. If a file type is checked, then files of that type will be
backed up.
The file types are combined to make an efficient list of files to backup. For example, if you
specify "*.*" and "*.LS" files to be backed up, ERBU knows enough to ask for "*.*" only. It
won't backup "*.*" and then again ask for "*.LS".

The File Type Dialog will be displayed.

File Type

This is the filter for the file type you want to backup. You can use full names or wildcards.
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The “Not” checkbox will remove files matching the filter from the list of files to be backed
up. For example, say you file TP files useless and you want to exclude them from a full
(*.*) backup. You can choose the *.* filter and then choose the \!.TP filter after it. When
ERBU gets the list of all files it will then go through the list and remove all the TP files from
the list before it starts its backup. For this reason, the order in which the filters are
displayed in the list matters. If the in the previous example, the !\*.TP filter came before
the *.* filter, then ERBU would remove all the TP files from an empty list and then add all
other files, so you would still be stuck with those annoying TP files.
There is another example of the importance of order in filtering by clicking the link at the
bottom of the Backup Settings window.

Description
This is used to indicate what the file might be used for. Optional.
Override Keys
Normally backup file types will include all the types marked with checkmarks in the File
Types list. Sometimes you might want to backup only certain file types temporarily. You
can specify an alpha (A-Z) key that can override the check-marked selection(s). To use
the override key, press and hold it when clicking the backup button on the main window.
When any override key is pressed, you will see the filter get adjusted on the lower left part
of the main window. Optional.

1.17

PREFERENCES WINDOW

The Preferences screen allows you setup the general behavior of ERBU. These are settings
that don't generally affect backups.
The Preferences screen is displayed by choosing “Preferences…” from the Setup drop down
menu on the main screen.
Below is a picture of the Preferences screen.
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A

B

C

D

E

Callouts have been added to help you find related information below.
A

ENABLE ADVANCED FEATURES

Choosing this option will enable some of the less common features that are normally grayed
out on the robot popup menu (displayed when right clicking a robot). This option is the same
as choosing "Enable Advanced Features" from the robot list popup menu. Some of the
advanced features include:
SMON via Telnet
Cycle Power
Run CF file locally…
Put file to FR…
When the Advanced Features are disabled, you can choose to have the disable features
hidden (removed from the list) or disabled (grayed out).
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A

OVERWRITE PROTECTED FILES WHEN PUTTING FILES TO ROBOTS

This option will cause ERBU to connect to the robot before attempting to send files to a robot
and remove any read-only protection on the files to be overwritten. Protection is removed for
all files before the first file is sent. If any file fails to get unprotected, you will be notified of the
first failure and all subsequent files will not be unprotected. Even if the protection fails, ERBU
will attempt to send the files anyway and you will be notified if the send fails. This function is
not brand specific, but it's only currently implemented on FANUC robots.
A

DOWNLOAD DETAILED ERRORS FROM ROBOT ON FAILED PUT ATTEMPTS

This option will cause ERBU to connect to the robot before attempting to send files to a robot
and get the error history. After a file fails to send, ERBU will download the error history again
and get the details of why it failed. This slows down sending files, but it helps debug syntax
errors when sending LS files to FANUC robots. The error details will be shown in the Transfer
Status list on the Transfer windows when a failure occurs. This is only implemented for
FANUC robots, I'm not sure if there is a valid implementation for other robot brands.
B

APPLY DRAG AND DROP OPERATIONS TO ROBOTS THAT ARE:

ERBU allows files to be dragged from Windows and dropped to the robot list. Files dropped
here can be configured to be sent to robots based on how they are selected in the robot list.
This behavior gets set up here. The choices are:
Highlighted - If this is chosen, then the robot that is currently highlighted will get the files
set to it. In this mode, drag and drop operations will only affect a single
robot since only one robot at a time can be highlighted. This can be
quicker than the Selected mode since you don't need to confirm the
checked or unchecked status of each robot before the drag and drop
operation.
Selected (Checked) - If this is chosen, then all the robots that have their checkboxes
checked will get the files sent to them. In this mode, drag and drop
operations can affect multiple robots. This is useful for dropping common
files to many robots at once.
NOTE: A confirmation dialog will be presented for drag and drop operations so that you can
verify the files being sent and the robots that will receive them.
C

RECALL PROJECT FILTER ON STARTUP

ERBU has the ability to apply filters to the project list on the main screen (by entering a filter to
the text box above the project list). This option allows you to recall the filter that was in use
the last time ERBU was closed. When the check box is checked, the filter will be recalled
automatically on start-up. If you've cleared the filter in the text box, and would like to recall it,
the last filter can also be recalled anytime by clicking the button next to the checkbox. The
last filter will be displayed on the button. If the button is not present, then a filter was not
being used the last time ERBU closed.
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C

RECALL ROBOT FILTER ON STARTUP

ERBU has the ability to apply filters to the robot list on the main screen (by entering a filter to
the text box above the robot list). This option allows you to recall the filter that was in use the
last time ERBU was closed. When the check box is checked, the filter will be recalled
automatically on start-up. If you've cleared the filter in the text box, and would like to recall it,
the last filter can also be recalled anytime by clicking the button next to the checkbox. The
last filter will be displayed on the button. If the button is not present, then a filter was not
being used the last time ERBU closed.
C

SHOW TIP OF THE DAY ON STARTUP

Selecting this will show some helpful tip when ERBU starts.
C

CHECK FOR UPDATES ON STARTUP

ERBU is often updated to add new features, improve performance, or fix bugs. Selecting this
option will cause ERBU to connect to the internet to determine if it’s up to date.
NOTE: Requires an internet connection.
NOTE: If you don’t want to use this option to check every time ERBU starts, you can still
periodically check manually by clicking the “Check Now” link.
D

IP ADDRESS MANAGMENT

ERBU has the ability to configure network profiles that can set your IP address and subnet
mask based on the project chosen. There are three techniques to manage the way the
network settings get changed.
Manual - In this mode, the network settings are never handled by ERBU and they must
be manually configured by you.
Automatic - In this mode, the network settings are handled automatically by ERBU.
Each time you select a different project, ERBU will wait a few seconds and then
try to change the network settings of your computer to the ones belonging to
the profile chosen for the project.
Prompt - In this mode, the network settings are handled semi-automatically by ERBU.
Each time you select a different project, ERBU will wait a few seconds and if
your current computer network settings don't match the ones expected by the
project, it will prompt you for permission to change the settings.
D

COMPRESSION PROGRAM

This allows you to set the path to your preferred file compression program. File compression
is used when archiving backups. If you have a preference to the program used, you can
configure it here. If it's not specified, the built-in Windows compression is used.
NOTE: Browse for the program by clicking the link.
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Supported programs include WinRar, WinZip, 7Zip.
D

TERMINAL PROGRAM

This allows you to set the path to your preferred telnet client. The telnet client is used for
connecting to the robot for things like KCL, TP emulator and SMON. If it's not specified, the
telnet client that ships with Windows is used. PowerTerm has been tested and is the best
supported client for ERBU.
NOTE: Browse for the program by clicking the link.
NOTE: Hold shift while clicking the link to restore to the default Windows telnet.exe (assuming
feature is enabled).
NOTE: You can use ERBU as your terminal program for KCL by setting the path to point to
the ERBU.exe itself. In this mode it will use an HTTP connection to emulate a telnet
connection. The KCL command set will likely be censored by the system variable
[HTTPKCL]cmds.

D

FTP PROGRAM

This allows you to set the path to your preferred FTP client. The FTP client is used for manual
FTP transfers. If it's not specified, the FTP client that ships with Windows is used. The
Windows FTP client is the best supported client for ERBU. Many FTP clients fail to be
compatible with FANUC robots due to their multi-character drive letters (MD, FR, etc).
NOTE: Browse for the program by clicking the link.
NOTE: Hold shift while clicking the link to restore to the default Windows ftp.exe (assuming
feature is enabled)

D

FILE EXPORER

This allows you to set the path to your preferred file explorer. There are many third-party file
explorers that are far more powerful than Windows Explorer. XYPlorer 14.50 and newer is
supportred.
NOTE: Browse for the program by clicking the link.
NOTE: Hold shift while clicking the link to restore to the default Windows Explorer.
D

DATABASE

This allows you to set the database that gets used by ERBU. The database contains the
projects and robots used by ERBU.
NOTE: Browse for the database by clicking the link.
D

DEFAULT BACKUP ROOT DIRECTORY
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This allows you to set the path where robot backups will go if a project does not specify a
location.
NOTE: Browse for the directory by clicking the link.
D

DEFAULT SOURCE CODE DIRECTORY

This allows you to set the path location where Windows Explorer will open when you choose
to Explore Source Code (either from the File menu or right-clicking a project).
NOTE: Browse for the directory by clicking the link.

1.18

WARPING WINDOW

The WarPing utility is a network tool used to detect IP addresses on an attached network.
You can access it from Setup>Network>WarPing.
WarPing will loop through addresses on the network and return the ping results for each.

Connected Networks
This dropdown allows you to choose what network WarPing will examine. Only networks that
are available are valid.
Current IP
This is the current IP Address of the computer running ERBU for the selected network.
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Current Subnet
This is the current Subnet Mask of the computer running ERBU for the selected network.
Include Octet
These are the parts of the IP Address that WarPing will loop though and examine. Currently
only the last octet is selectable. This is due to the large time commitment to loop through
more than this octet.
Found Addresses
This shows a list of the IP addresses found on the network. If ARP is used, then the MAC
addresses are also listed for each IP Address. The number of IP addresses detected is also
shown.
Use ARP
If this is checked, WarPing will use Address Resolution Protocol to determine the MAC
addresses for the IP addresses it detects. Some networks do not allow ARP.
If you have Use ARP chosen, then you will be given extra choices on how the detected ARP
information is displayed.
Raw MAC
If Raw MAC is selected, then in addition to the IP address, the Found Addresses list will
show the MAC address detected for each IP address.
Vendor
If Vendor is selected, then in addition to the IP address, the Found Addresses list will
show the Vendor (manufacturer) associated with the MAC address detected for each IP
address.
NOTE: ERBU has a short list of vendors built into it. For vendors not in the built-in list,
ERBU will show the raw MAC address. If ERBU has internet access at the time of the
scan, it will attempt to look up the unknown MAC address vendor from databases available
on the internet and use that information. Vendors learned from the internet will be added
to the ERBU built-in list.
Progress Bar
As WarPing scans the network, the progress toward completion is shown here.
Find Button
Starts WarPing scanning the network.
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1.19

NETWORK PROFILE MANAGER

The Network Profile Manager is a utility that is used to configure network configurations
making it easy to switch your computer’s configuration to match what is expected for the
robots you are working with. The profiles setup here can be assigned to projects so that when
a project is chosen the network configuration can be automatically switched with it. The
network profile manager is accessed through the main menu under
Setup>Network>Profiles…>Manage.

The window above shows a list of configured profiles and a menu bar where you can add,
delete, edit and switch between profiles.
Add
This button will bring up a dialog box where you can setup a new profile.
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Profile Name
Here you enter the name of the profile. The name should be something
descriptive so you can identify it easily. Good practice would be to include the
network card it affects and possibly the project or customer it goes with.
Network Connection
This dropdown will show the network cards currenty available and that are
configurable.
Local IP Address
This setting is the IP address that will be assigned to the network card when the
profile is chosen. If you want to use the current IP address for the card you can
click the “Use current” link beside the entry box. If you want this card to get its
address from a DHCP server, you can click the “DHCP” link.
Local Subnet Mask
This setting is the Subnet Mask that will be assigned to the network card when
the profile is chosen. If you want to use the current Subnet Mask for the card you
can click the “Use current” link beside the entry box. If you want to use the
common 255.255.255.0 mask, you can click the “FF.FF.FF.0” link. If DHCP has
been chosen for the IP Address, then you cannot change the subnet mask.
Default Gateway
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This setting is the IP address of the default gateway that will be assigned to the
network card when the profile is chosen. If you want to use the current gateway
address for the card you can click the “Use current” link beside the entry box.
Wireless Network
This entry box will only be enabled if the network card you’ve chosen is a
wireless network card. This dropdown will be populated with the wireless
networks currently detected. You can type the name of a network here if it’s
known and not shown. The refresh link will refresh the wireless networks that are
available. The Auto Join check box will cause the profile to attempt to connect to
the wireless network when it’s chosen.
Optional Run
This is not yet implemented. When it is, you will be able to specify a command
line argument to another application when the profile is chosen. This may be
useful if you use a third-party application to manage your wireless adapter.
Delete
This button prompts you to confirm you want to delete the currently selected profile. A profile
must be chosen for the Delete button to be active. All projects using this profile, will be
converted to being unmanaged meaning you will be responsible for manually configuring the
network cards to be compatible with robot network.
Properties
This button will bring up a dialog box where you change the settings of the selected profile.
The dialog is identical to the Add profile dialog except that it gets prepopulated with the
profile’s current settings. You can modify the profile however you want, but if you change the
name a new profile will be created with the new name. In this way, you can copy an existing
profile’s settings to a new profile.
Apply
This button will take the settings of the currently selected profile, and configure the network to
match the settings within the profile.

1.19.1 CHOOSING A NETWORK PROFILE
This section assumes you have setup a profile and you want to assign it to a project or
manually chose and apply it. Depending on how you have your IP Address
Management preferences set, the profile may automatically be applied when a project
is chosen. See section 1.17 for a description of this preference. Of course this also
assumes the project has a profile assigned to it.
Assigning a profile to a project
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If you are creating a new project, you will have the option to choose a network profile
from the configured profiles dropdown list. If you don’t have any profiles configured,
you will be forced to choose “None”. See below.

Assigning a profile to an existing project
Assigning a profile to an existing project is as simple as right-clicking a project and
choosing Properties and then choosing a profile just as you would if you were add in a
new project. Alternatively, you can access the project properties by highlighting the
project in the project list an clicking the Properties button above the list.
If you want to change network profiles without changing projects (or if your preferences
are set to not change profiles with the project), you can choose to apply a profile
manually. To do this, you can go to the Network Profile Manager, choose a profile and
apply it. See section 1.19 for how to do this. Alternatively, you can choose a profile
from the list on the Setup>Profiles menu. See below.

Available profiles 
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1.20

AUTO BACKUP SCHEDULER

ERBU has a feature that allows you to schedule backups on regular intervals. It does some
semi-automatic configuration to the Windows Task Scheduler. The best way to think about
auto backup is that it launches ERBU, changes to the project that was specified on the
command line, and then clicks the Backup button.
There are some things to consider when configuring an auto backup.
 Only one project can be scheduled to run at a time.
 Only the robots that were check marked in the project the last time ERBU closed will be
backed up.
 Only the filter types that are chosen for that robot brand the last time ERBU closed will
be backed up.
 While the progress is shown during the backup, no message dialogs will be displayed.
This is because it is assumed that the reason you set up an auto backup is because the
backup will be unmonitored.
 Of course, the computer must be running and attached to the network for the backup to
work.
To add a project to the auto backup schedule, you can set it when creating the project or if the
project already exists, you can right click the project and choose its Properties. From the
properties page, click the Auto Backup link.

If there isn’t already an auto backup for the project, you will be prompted to have the project
name added automatically. If you choose Yes, then the name will be added in the proper
location in the scheduler. If you choose No, then you will need to set up the backup manually.
If you don’t want to schedule a backup either automatically or manually, choose Cancel.
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If you’re familiar with Windows Task Scheudler then the setup should be easy one you know
what information is required. If you ever want to modify a scheduled backup or run one
manually, you can get to the Windows Task Scheduler through the Setup>Auto Backup
Scheduler menu.

A

B

C

Callouts have been added to help you find related information below.
A

ERBU Folder
All ERBU backups are contained in their own folder. This is not a requirement for the
backup to work, but ERBU will only look in this folder to determine if an auto backup is
scheduled.

B

Project Names
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This area shows a summary of the projects scheduled for backup.
C

Settings
This area has tabs that allow you to setup various properties of the backup. The main
tabs you’ll be dealing with for a proper backup are described below.
General Tab
Shown below. This tab shows the descriptive properties of the scheduled task. To
change the properties, right-click the task in area “B” and select Properties.
The Name can be anything you want, but ERBU will only recognize the project as being
configured if the task name matches the project name.
The Location should match the folder name in area “A”. The default location given by
ERBU is the ERBU folder.
The Description can be anything you want. The default description given by ERBU is
‘ERBU Automatic backup of <project name>’.

Triggers Tab
Shown below. This tab shows the time and frequency of the scheduled backup. To
change the time or frequency, right-click the task in area “B” and select Properties.
The trigger must be enabled for the backup to occur.

Actions Tab
Shown below. This tab shows the command line that will start ERBU. The command
line should contain the path the to the ERBU executable (in quotes) followed by the
name of the project to back up (not in quotes).

Page 80

ERBU User’s Manual

1.21

TRANSFER WINDOW

Once a backup (or another type of transfer) is started, a transfer window will be shown
that will display the progress and status of the transfer. The Transfer Window is shown
below.

A

B

C

Callouts have been added to help you find related information below.
A

Cancel
This button will cancel all active transfers.
Clean Up
This button will remove all finished transfers from the Transfer Progress list. The
Transfer Status list will be cleared for transfers that get cleaned up.
Setup Menu
This menu item will display a window where you can set preferences for the Transfer
Window.
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Close Transfer Window if all transfers complete successfully
This will close the transfer window automatically once all transfers complete and
they are all successful.
Restore the Transfer Window if it’s minimized when a transfer starts
This will display the Transfer Window even if it has been minimized to the
Taskbar whenever a transfer starts.
Auto clean up sucessful transfers
This will automatically remove sucessful transfers from the Transfer Progress list.
Auto clean up successful transfers when a new transfer starts for the same
robot
This option will remove completed backups from the Transfer Progress list if you
start a new transfer for that robot. Normally, you would need to manually
cleanup the Transfer Progress list before you would be allowed to start a new
transfer. In his way you are required to acknowledge the status of the transfer. If
you don’t care to cleanup to acknowledge, then use this checkbox.
Warn if a new transfer is started for a robot that still has transfers pending
This will force a prompt to be displayed if you start a transfer for a robot that is
already transferring. Only a single transfer can be active for any given robot. If
you leave this box unchecked, then no prompt will be displayed (the transfer
request will just be ignored).
B

TRANSFER PROGRESS
This list will show the progress of the transfer.

Page 82

ERBU User’s Manual
Robot Name
The first column is the name of the robot that has an active/pending/completed transfer.
To the left of the robot name is an icon that indicates the overall status of the transfer.
The meanings of the icons are shown below.
OK (download)

Bad (download)

OK (upload)

Bad (upload)

OK (get)

Bad (get)

OK (put)

Bad (put)

No status/FTP Errors
Path
The second column shows the remote path of the robot being backed up. This is the
robot directory where the files are currently being transferred to or from.
File
The third column shows the name of the file currently being transferred.
Progress
The last column shows a progress bar that indicates the amount of progress toward
completion of the overall transfer.
C

TRANSFER STATUS
This list will show the individual status for each file transferred. This is useful for
transfers of multiple files, so you can see exactly which file(s) failed.
Item
The first column shows the name of the file that was backed up. This includes the path.
Status
The second column shows the results of the transfer for each file transferred. OK
indicates the file transfer was successful. Any status besides OK is considered a failure.
If you have your preferences set to show detailed errors, then the status area will show
specifically the line number that a put transfer failed on (FANUC only). See Section 1.17
for information on the Preferences Window.

1.22

SYSVAR WINDOW

The Common Sysvar window allows you to save notes on some of the more commonly used
system variables. This allows you to quickly find information on system variables so that you
can recall their usage or settings in your own words.
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Below is a picture of the Common Sysvar window.

A

B

Callouts have been added to help you find related information below.
A

TOOLBAR

This area of the window allows you to add, remove and search for system variables.
To add a system variable, click the add (

) button, and then enter a name and a description.

To remove a system variable, select the sysvar you want to remove and then click the remove
( ) button. You will be prompted to confirm the deletion.
To search your notes, type the text you want to find in the textbox. As matching text is found,
the textbox will turn green and the found occurrences will be highlighted in bright yellow in
your notes. If no match is found, the textbox will turn red.
B

NOTES

This area of the window will display a list of the system variables you’ve previous added. The
currently selected system variable is highlighted (blue in the example above).

1.23

SEND KCL WINDOW

The Send KCL window is only valid for FANUC robots that have the PC Interface option
installed. It allows you to send KCL commands from a text file located on the local PC. To
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access this feature for a robot, right-click the robot on the Main Window and choose “Run a
CF locally”.
See Section “ROBOT RIGHT-CLICK POPUP MENU” for more information on launching this
window. If you need information on the KCL language, you should read the Karel Command
Language section in a FANUC HandlingTool/SpotTool Manual.
Before the window launches, you will be prompted for a CF file to load. The Send KCL
window is not an editor, so the CF file is expected to already exist.
The Send KCL Window is shown below.

C

B

A

Callouts have been added to help you find related information below.
A

LINE NUMBERS

This area of the window will give each line of the CF file its own number.
B

KCL COMMANDS

This area of the window shows the KCL commands loaded from the CF file. The current line
(where execution will start) will be highlighted in blue. To change the current line, click on the
line of your choice. You cannot edit the file in this window.

C

EXECUTE

This button will send the KCL command(s) to the robot. In step mode, only one command will
be sent with each click.
If an error is encountered, the execution will stop on the line that caused the problem, highlight
it in red and display a prompt box. You can use the Enter key to click the Execute button too.
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C

STEP MODE

This button allows you to change the behavior of the “Execute” button. If checked, the
Execute button will only execute the current line and then choose the next line as the current
line. When unchecked, the Execute button will run all commands from the current line until
the end of the file or until an error is encountered. Step mode is always selected by default.
C

FILE MENU

The file menu allows you to perform some basic functions on the loaded CF file.
The File menu has the following choices:
Edit
Load
Reload
Edit
This will open an editor where you can edit the loaded file. The editor it uses depends on the
editor you have associated with CF files in Windows.
Load
This will open a file dialog where you can choose a new CF file to load from disk.
Reload
This will reread the loaded file from the disk. This is useful if you’ve edited it in another
program and just need to refresh it in the Send KCL Window.

C

DONE

This button closes the Send KCL window.

1.24

SYCHRONIZE CLOCKS WINDOW

The Synchronize Clocks window will allow you to set the robot’s system clock so that it
matches the system clock of the local PC. Having synchronized clocks is useful for accurately
determining when backups were made and when files might have been edited on the robot.
This functionality is only available for FANUC robots.
You can get to this window by right-clicking the robot whose clock you want to set and
choosing “Synchronize Clock”. See Section on the ROBOT RIGHT-CLICK POPUP MENU for
how to do this.
If you choose to synchronize clocks on a virtual robot, you will be warned about some
complications it can cause before the Synchronize Clocks window opens.
The window is shown below.
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The window is divided into sections.
The top line of the window shows the robot that will be affected by the clock change.
The Local PC Clock section shows the current time of the local PC.
The Time Zone Adjust section allows you to apply an offset to the Local PC clock before
synchronizing it to the robot. This is especially useful if you’re temporarily working at a
customer facility that might be located in a different time zone and you want to sync a robot
with your laptop.
The Remote Robot Clock section shows the current time of robot to be synchronized.
The adjusted Robot Clock section shows what time the robot will show after the
synchronization.
Apply
This button will send the adjusted time to the robot. This button will be disabled for Virtual
Robots because of complications it can cause. If you want to override this, you can press the
shift key to enable it.
Done
This button closes the Synchronize Clocks window.

1.25

IMAGE BACKUP PROCESS

The FANUC image backup process over Ethernet is pretty easy, but it requires a little manual
input.
Starting with R30iA controllers, you can start an image backup right from the File screen. Or
for older controllers you will need to start an image backup from the BMon (F1+F5) menu.
NOTE: The image process over Ethernet is a little easier if you set the robot’s MAC address in
ERBU. To set this, right click the robot, choose properties and then enter the MAC address
manually or if the robot is available, click the Robot MAC address link to auto detect it.
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The process shown in this section uses the BMON method since it’s applicable to more
robots.
1) Boot the robot in to the Boot Monitor Menu by cycling power on the robot while pressing
and holding the F1 and F5 keys.
2) After booting, the robot will arrive at the menu shown below. Choose “Controller
backup/restore”.
*** BOOT MONITOR ***
Base version V8.20P/P42 [Release 3]
******* BMON MENU *******
1. Configuration Menu
2. All software installation(MC:)
3. INIT start
4. Controller backup/restore
5. Hardware diagnosis
6. Maintenance
7. All software installation(Ethernet)
8. All software installation(USB)
Select:

3) The next menu is shown below. Choose “Backup Controller as Images”.
*** BOOT MONITOR ***
Base version V8.20P/P42 [Release 3]
Select: 4
******* BACKUP/RESTORE MENU *******
0. Return to MAIN Menu
1. Emergency Backup
2. Backup Controller as Images
3. Restore Controller Images
4. Bootstrap to CFG MENU
Select:

Page 88

ERBU User’s Manual
4) The next menu is shown below. Choose “Ethernet(TFTP:)”.
*** BOOT MONITOR ***
Base version V8.20P/P42 [Release 3]
4. Bootstrap to CFG MENU
Select: 2
** Device selection menu ****
1. Memory card(MC:)
2. Ethernet(TFTP:)
3. UBS(UD1:)
4. USB(UT1:)
Select:

5) The next menu is shown below. At this point we need to get ERBU ready to accept the
image files.
*** BOOT MONITOR ***
Base version V8.20P/P42 [Release 3]
Select: 2
**** BACKUP Controller as Images ****
Module size to backup:
FROM: 64Mb SRAM: 2Mb
Disk space required on remote host is
64Mb free space.
Are you ready ? [Y=1/N=else]:

6) On ERBU, right click the robot you want to backup. From the popup menu choose “Image
Backup…”.

7) If you have a firewall enabled, ERBU will remind you to configure or disable your firewall to
allow network traffic through.
8) After acknowledging the firewall prompt, you will see the window below.
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The information on this screen should correspond to the IP address you have configured for
the robot, the Name of the robot, and the MAC address of the robot.
The area labeled “Requests” will show a list of boot requests as they come in.
9) At this point you can go back to the robot and Choose “Yes”.
10) The robot will ask for an IP address and ERBU will supply one. Once the robot has an IP
address, it will prompt you to confirm.
*** BOOT MONITOR ***
Base version V8.20P/P42 [Release 3]
Initializing ethernet. Please wait…
Trying BOOTP on Port 1 ,..
Hostname:
IP Address : 192.168.1.97
Subnet Mask: 0.0.0.0
Router
: 0.0.0.0
TFTP Addr : 192.168.1.69
TFTP Path : Labbot
Accept? [1=Yes][Other=No] >

11) If the MAC address for the robot was supplied in the robot properties in ERBU and it
matches the device requesting the boot, then ERBU will automatically send the IP address
and switch to the TFTP server. If no MAC address was supplied in the robot properties in
ERBU, then ERBU will supply IP addresses to all robots requesting a boot and you will
need to click the “TFTP” button once the robot you want gets the IP address.
12) When ERBU enters the TFTP mode, you will see a window like the one below.
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When backing up in the BMON menu, the robot will send image files and then request
them back from the robot to verify the file made it intact. This obviously adds time to the
backup process. You can skip the verify steps by choosing the “Skip Verify” option. This
feature only works on R30iB controllers. It’s not a good idea to skip this on networks that
have a lot of traffic, or if you want the comfort of knowing the images were double
checked.
13) At this point, ERBU is waiting to accept images from the robot. Go back to the robot and
choose “Yes”.
14) The robot will start sending files and ERBU will write them to disk. The path where the
image files are being saved is shown as a link to the Default Path. Clicking this link will
take you to the folder. The progress of the backup can only be determined by the size of
the robot memory and the number of files created. There is one file created for each
megabyte of memory the robot has.
15) Once all the files are sent, the robot will return to the Boot Monitor Menu and ERBU will
show “Complete?”.
16) From the robot choose Configuration Menu to get to Controlled Start and then to Cold
Start.
17) From ERBU click Done.
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1.26

KCL COMMANDER

If you right-click a robot in the Robot list and choose “KCL via Telnet”, then your preferred
Terminal program will launch a Telnet connection to the robot. If you have configured ERBU
to be the preferred Terminal program (from the Preferences window), then ERBU’s built-in
KCL Commander terminal will launch.
Below is a screen shot of the KCL Commander window.

The window is non-modal, meaning you can use the other ERBU windows while KCL
Commander is open. The top of the window will have a menu bar that will let you configure
settings of KCL Commander.
Settings
This menu item will display the Settings window.
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The Show Suggestions checkbox will configure KCL Commander to suggest valid KCL
commands based on what you’ve started typing. The suggestions can be seen showing
commands in the full window screen-shot above.
The Clear Screen setting will configure how the Clear Screen menu works. It notes that “CLS”
can be used to execute the Clear Screen command. CLS is not a KCL command; it’s only
used by KCL Commander. The CLS command always clears all.
Clear Screen
This menu will clear the screen based on how you configured its behavior in Setting.
Tools
This menu will display some tools that will help make KCL Commander work better with your
robot.

Add this PC to FSAC
This choice will prompt you to add this PC’s IP address to the FSAC table. FSAC stands
for FANUC SERVER ACCESS CONTROL. FSAC is a whitelist of IP addresses
approved for access to servers on the robot. If FSAC is configured on the robot, then
only PC’s with approved addresses can access the robot. If you attempt to run a KCL
command and it is rejected by FSAC (KCL Commander will tell you this), then you can
use this menu to add your IP address to the whitelist.
NOTE: This feature requires the PC Interface option on the robot and Robot Server on
your PC.
Unlock KCL
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This choice will prompt you to unlock the HTTP server on the robot.
If you get an error 403 (forbidden) when executing a KCL command, then the HTTP
server is probably locked. You can use this menu to unlock it remotely.
NOTE: This feature requires the PC Interface option on the robot and Robot Server on
your PC.
Unprotect command set
This choice will prompt you to uncensor the list of KCL commands allowed through
HTTP.
If you get a ‘Protected KCL command’ error, then the command you entered is probably
one of the many KCL commands that are not allowed by default through HTTP. You can
use this menu to allow all commands.
NOTE: This feature requires the PC Interface option on the robot and Robot Server on
your PC.
Set $RMT_MASTER
This will allow you switch the master device that can start programs. The choices are:
0 = UOP’s: This will use UOP signals to start the robot.
1 = CRT/Keyboard: This will allow running using the CRT/Keyboard manager.
2 = Host PC: This will allow PC Interface connections to start the robot
3 = None
The main KCL window will show the KCL prompt. If you have configured suggestions ON,
then as you type, you will see the formats of suggested commands. You can even click these
suggestions to auto-complete the command. If you start typing a system variable, KCL
commander will check your sysvar list and use these to suggest choices.
Below the main KCL window, you will see a Troubleshooting link that will remind you of some
of the things pointed out in this section. This link will display this message.
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1.27

FUTURE PLANS



Expand the functionality of the FANUC robot Image Analyzer tool.



Reintroduce Housekeeping – Needs to make better use of threads to prevent system
resource hogging.
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